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1. Copyright Notice

© Copyright 2023 Esko Software BV, Gent, Belgium

All rights reserved. This material, information and instructions for use contained herein are the
property of Esko Software BV. The material, information and instructions are provided on an AS IS
basis without warranty of any kind. There are no warranties granted or extended by this document.
Furthermore Esko Software BV does not warrant, guarantee or make any representations regarding
the use, or the results of the use of the software or the information contained herein. Esko Software
BV shall not be liable for any direct, indirect, consequential or incidental damages arising out of the use
or inability to use the software or the information contained herein.

The information contained herein is subject to change without notice. Revisions may be issued from
time to time to advise of such changes and/or additions.

No part of this document may be reproduced, stored in a data base or retrieval system, or published, in
any form or in any way, electronically, mechanically, by print, photoprint, microfilm or any other means
without prior written permission from Esko Software BV.

This document supersedes all previous dated versions.

PANTONE® Colors displayed in the software application or in the user documentation may not match
PANTONEéidentified standards. Consult current PANTONE Color Publications for accurate color.
PANTONE and other Pantone trademarks are the property of Pantone LLC. © Pantone LLC, 2015

Pantone is the copyright owner of color data and/or software which are licensed to Esko to distribute
for use only in combination with Studio Visualizer. PANTONE Color Data and/or Software shall not be
copied onto another disk or into memory unless as part of the execution of Studio Visualizer.

This software is based in part on the work of the Independent JPEG Group.

Portions of this software are copyright ©1996-2002 The FreeType Project (www.freetype.org). All
rights reserved.

Portions of this software are copyright 2006 Feeling Software, copyright 2005-2006 Autodesk Media
Entertainment.

Portions of this software are copyright ©1998-2003 Daniel Veillard. All rights reserved.
Portions of this software are copyright ©1999-2006 The Botan Project. All rights reserved.

Part of the software embedded in this product is gSOAP software. Portions created by gSOAP are
Copyright ©2001-2004 Robert A. van Engelen, Genivia inc. All rights reserved.

Portions of this software are copyright ©1998-2008 The OpenSSL Project and ©1995-1998 Eric Young
(eay@cryptsoft.com). All rights reserved.

This product includes software developed by the Apache Software Foundation (http://
www.apache.org/).

Adobe, the Adobe logo, Acrobat, the Acrobat logo, Adobe Creative Suite, lllustrator, InDesign, PDF,
Photoshop, PostScript, XMP and the Powered by XMP logo are either registered trademarks or
trademarks of Adobe Systems Incorporated in the United States and/or other countries.

Microsoft and the Microsoft logo are registered trademarks of Microsoft Corporation in the United
States and other countries.

SolidWorks is a registered trademark of SolidWorks Corporation.

Portions of this software are owned by Spatial Corp. 1986 2003. All Rights Reserved.
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JDF and the JDF logo are trademarks of the CIP4 Organisation. Copyright 2001 The International
Cooperation for the Integration of Processes in Prepress, Press and Postpress (CIP4). All rights
reserved.

The Esko software contains the RSA Data Security, Inc. MD5 Message-Digest Algorithm.

Java and all Java-based trademarks and logos are trademarks or registered trademarks of Oracle
corporationin the U.S. and other countries.

Part of this software uses technology by Best Color Technology (EFI). EFl and Bestcolor are registered
trademarks of Electronics For Imaging GmbH in the U.S. Patent and Trademark Office.

Contains PowerNest library Copyrighted and Licensed by Alma, 2005 - 2007.

Part of this software uses technology by GlobalVision. ArtProof and ScanProof are registered
trademarks of GlobalVision Inc.

Part of this software uses technology by Qoppa Software. Copyright © 2002-Present. All Rights
Reserved.

All other product names are trademarks or registered trademarks of their respective owners.
Correspondence regarding this publication should be forwarded to:

Esko Software BV

Raymonde de Larochelaan 13

B - 9051 Gent

info.eur@esko.com
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2. Overview of a WebCenter Installation

The WebCenter installation procedure involves a number of different steps that need to be performed
in a specific order.

The table below shows a list of the steps required to install WebCenter either for the first time oras an

upgrade:

Step

Description

1

Check the Requirements and perform pre-installation work:

« Hardware and Software Requirements on page 7

« Pre-Installation Steps on page 18

Installing WebCenter on page 22:

Install SQL Server 2017/2019 Express Edition on the Database Server on page 23
Install ArtiosCAD Enterprise on the Application Server on page 24

Install the WebCenter Application Server on page 26

Install the WebCenter Web Server on page 33

Start the WebCenter Services on page 34

Install the On-Board Graphics Engine (OBGE) on the Application Server on page 35

o0 s aN -

Testing WebCenter on page 38

Configuring WebCenter on page 39:

Configure the OBGE on page 39

Configuring the E-Mail Notifications on page 40

Secure your WebCenter Site with SSL on page 45

Install Certificates for LDAPS on the Application Server on page 57
Integrate WebCenter with a Workflow Production Server on page 60
Expose WebCenter to the Internet on page 64

IR
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3. Hardware and Software Requirements

/b Attention: For the latest hardware and software requirements, please check the Esko website.

It also has a FileStore and an On-Board Graphics Engine (OBGE), which is used to generate view data.

New IT Requirements From WebCenter 22.03 Onwards

From 22.03 onwards,WebCenter only supports Windows Server 2016 or later for fresh installations. For
the latest hardware and software requirements, please check the Esko website.

Entry Level (Two Server Systems Required)

WebCenter Entry Level requirements are based on an activity with 10 concurrent users active at any
time and less than 100 users in the system. Customers with higher performance needs should refer to
the Advanced Level requirements.

Inthe Entry Level setup, the installation of the Application Server and Database Server is combined
onto a single machine. The OBGE and the FileStore are on the Application Server.

For reasons of security the Web Server is always on its own dedicated computer and placed in a
demilitarized zone (DMZ). We recommend the use of hardware firewalls for creating the DMZ.

Advanced Level (Three or More Server Systems Required)

When the WebCenter Entry Level cannot meet the load requirements of the system, it is possible to
scale the system.

For reasons of security the Web Server will always be a separate computer in a DMZ.

Each of the other WebCenter components (Application Server, Database Server, FileStore and OBGE)
can be offloaded onto separate machines in different combinations.

For Advanced Level installations, it is recommended to choose the Advanced Installer option to allow
more custom configuration, and to choose Extra Large for the Deployment Size.

Requirements
Category Entry Level(Standard-<100 | Advanced Level (Extra Large -
users) 100+ users)
Operating System Microsoft Windows Server 2016 | Microsoft Windows Server 2016
or better or better

Processor - Application Server x86-64 Compatiplg Processor | x86-64 compatible processor
with On-Board Graphics Engine | (Intel or AMD), minimum 8 cores | (jntel or AMD), minimum 12
cores, 6 + 6 per 100 users

Processor - All other WebCenter | X86-64 compatible processor | xg86-64 compatible processor
Servers (Intel or AMD), minimum 4 cores | (Intel or AMD), minimum 6
cores, 2+ 4 per100 users, 2+6
per 100 users for separate DB
server
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Category

Entry Level (Standard - <100
users)

Advanced Level (Extra Large -
100+ users)

RAM Memory (Application Server
with DB and OBGE)

16 GB or more

Not Supported

RAM Memory (Application Server
with OBGE)

16 GB or more

28 GB or more

RAM Memory (Application Server)

12 GB or more

18 GB or more

RAM Memory (Separate Database
Server)

12 GB or more

minimum 12 GB or the size of
the DB (whichever is larger),

add 8 GB per 100 users
RAM Memory (Web Server) 6 GB or more 12 GB or more
Available hard disk space - 30 GB or more 60 GB or more
Application Server
Available hard disk space - Web | 30 GB or more 60 GB or more
Server
Available hard disk space - 50 GB or more 100 GB or more

Database Server

Available hard disk space - File
Store

150 GB, should be expandable as
data storage grows with usage.

For WebCenter to perform
according to expectations,
the FileStore needs to be on
Windows file servers.

Recommended to use Windows
Server 2016 or later as file
server (but ReFS data volumes
are not supported yet).

Display

1024 x 768 pixels, 16-bit color
minimum

1024 x 768 pixels, 16-bit color
minimum

Media drives - Application Server

DVD-ROM or connection to
networked DVD-ROM drive

DVD-ROM or connection to
networked DVD-ROM drive

Media drives - Web Server

DVD-ROM or connection to
networked DVD-ROM drive

DVD-ROM or connection to
networked DVD-ROM drive

Network (all servers)

10/100/1000 Base-T Ethernet,
TCP/IP v4 protocol

10/100/1000 Base-T Ethernet,
TCP/IP v4 protocol

Database software

« Microsoft SQL Server
2012/2014/2016/ 2017/2019
(Express Edition, Workgroup

« Microsoft SQL Server
2012/2014/2016 /2017/2019
(Workgroup Edition,
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Category Entry Level (Standard-<100 | Advanced Level (Extra Large -
users) 100+ users)
Edition, Standard Edition, Standard Edition,
Enterprise Edition) Enterprise Edition)
« Oracle 19¢c/21c Enterprise « QOracle 19¢c/21c Enterprise
Edition Edition
Note: Oracle 12¢ Note: Oracle 12c
and older are no and older are no
longer supported. longer supported.
Notes

WebCenter 22.03 or later version only supports TLS v1.2 or higher out of the box. When upgrading
or installing WebCenter 22.03 or later version, this can result in WebCenter refusing to connect to
the Database Server. Typically this issue can be solved by installing the relevant service packs for
the SQL Server installation (see this page for more info).

Please check the following Knowledge Base article for more information: KB358434440: WebCenter
- Cannot connect to SQL Server 2014 or SQL Server 2012.
The Database Server needs 10 GB of free space on the partition containing the database files to

allow for database expansion.

If you install the Global Vision extension on the OBGE, the OBGE needs to be separated from the
WebCenter Application Server.

If you install the additional Automation Engine Processor module license for WebCenter, the OBGE
needs to be separated from the WebCenter Application Server.
The Application Server is the default location for uploaded files (also known as the FileStore).

Ensure it has at least 50 GB of available hard drive space, and that the disk space is expandable.
Alternatively, find a network location with expandable disk space to specify as the file storage
location when loading the Application Server.

The Web, Application and Database Servers must have the same OS language, regional setting
(suchasEnglish (United States)) andtime zone setting.

If you are using a Microsoft Hyper-V hypervisor virtual machine, do not install both the WebCenter
Web Server and the Esko Licensing software on this virtual machine.



https://support.microsoft.com/en-us/topic/kb3135244-tls-1-2-support-for-microsoft-sql-server-e4472ef8-90a9-13c1-e4d8-44aad198cdbe
https://wiki.esko.com/display/KBA/KB358434440%3A+WebCenter+-+Cannot+connect+to+SQL+Server+2014+or+SQL+Server+2012
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Licenses
« WebCenter Licenses
To install WebCenter 23.11, request for the WebCenter 23 licenses.

The old WebCenter 22.x, 21.x, 20,18.x, 16.x, 14.x or 12.x licenses will not work anymore.

«  WebCenter supports two types of licensing models. You can have counted licenses in the Named
User Model and Concurrent License Model where you can have licenses that are taken up during a
log-in sessions.

- Named User Licenses: A named user license is an exclusive license of rights assigned to a

single software user. This License model lets you pay for the number of users you want to create

in WebCenter. This means that the purchased number of licenses (per type of users) limit the
number of users that can be created. Read more in: Licensing and Users and in this FAQ.

- ConcurrentLicenses:

In this model, you can create as many users as you want. The number of users who may use
the system at the same time is determined by your Concurrent Licenses. The licensing model
distinguishes between three types of users: guaranteed users, concurrent users, and editor
users.

WebCenter

Note: Since WebCenter 14.0.2, large installations from 50 concurrent users require
a WebCenter Advanced License. A special 'advanced' variant of the concurrent user
licenses is also needed in this case.

Network Licensing Tool

For WebCenter 23.11, you need to install ArtiosCAD Enterprise 23.07, this installation includes the
required Network License Manager.

To know more about Network Licenses, check this Knowledge Base article.

Server Configuration
Port Configurations
Below you can find the ports which need to be open/available for proper functioning of WebCenter:

« Port 80 (HTTP)from the internet to the WebCenter Web Server (DMZ).

«  Port 443 (HTTPS)from the internet to the WebCenter Web Server (DMZ).

« Port 80 (HTTP)from the LAN to the WebCenter Web Server (DMZ).

«  Port 443 (HTTPS)from the LAN to the WebCenter Web Server (DMZ).

« Port 4444 from the WebCenter Web Server (DMZ) to the WebCenter Application Server (LAN).

« Port 5445 from the WebCenter Application Server to the Automation Engine server (LAN) for
approval feedback

« Port 25(SMTP)from the WebCenter Application Server (LAN) to the Mail Server.


https://docs.esko.com/docs/en-us/webcenter/22.11/quickstartguide/home.html#en-us/common/wc/concept/co_wc_LicensingandUsers.html
https://wiki.esko.com/display/KBAS/KB184729846%3A+WebCenter+-+FAQ+about+Licensing+in+version+16.1
https://wiki.esko.com/display/KBA/KB183799273%3A+WebCenter+-+How+does+licensing+work+in+WebCenter+16.1
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Note:

« The following ports are internal ports for the Application Server and need not be configured
on the firewalls. However, if any of these ports are taken by another application, the
Application Server will not start. Ports: 8083, 8086, 1161, 1162, 1090.

» The following ports are internal ports for the WebServer and do not need to be configured
on the firewalls. However, if any of these ports are taken by another application, the
WebServer will not start. Ports: 8081, 8009.

Note: It isrecommended to install the external viewer during the installation process.

Database

The database shipped as default with WebCenter 23.11is MSSQL 2017 Express.

OBGE

In case the OBGE 23.11is installed on the Web Server (not recommended), make sure to stop the EG
Web Server service before starting Tomcat.

Note: Since 16.1, Automation Engine no longer uses Hot Folders explicitly, but you can now
configure the FileStore JDF Hot Folder by creating an Access Point which is described in
Create a JDF Hot Folder (Access Point) for WebCenter.

IS

If you move to WebCenter 23.11 from WebCenter 12.x, leaving the installation of lIS intact, a
change to IS may be needed. In lIS, go to Application Pools and open the Advanced Settings for
DefaultAppPool. Make sure that ‘Enable 32-Bit Applications’is set to ‘False’. After changing the
setting, click 'Recycle’.

Simple or Advanced Installation

Since WebCenter 14, it is possible to choose between a Simple or Advanced installation. If the
Advanced installation mode is selected, the memory size allocated for the JBoss service on the
Application Server and the TomCat service on the Web Server need to be specified. Choosing the
Extra Large option is recommended for servers that are expected to experience a heavy load and
high concurrent user access.

Internal or External Viewer

In case of an Advanced installation, the Viewer service can be set to Internal or External. Selecting
External will make the Viewer service run as a separate process. Note that choosing External
requires extra ports to be opened between the Application and Web Server: 14444. And the
following ports need to be available for the application server: 1091, 3528 and 4446.

Database user

In case of an Advanced installation, it is possible to set a custom password for the WebCenter
database user.

Boards

Previously, in older versions of ArtiosCAD Enterprise, the Boards needed to be installed by running
a .bat file after the WebCenter installation. Since ArtiosCAD Enterprise 14.0, you can install the
Boards automatically during the ArtiosCAD Enterprise installation, this is highly recommended.

n
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5. Installation Checklist

The Installation Checklist can be used as a tool alongside the rest of the Installation Guide to ensure
you completed all the necessary steps during the installation. There are two versions, the first one can
be used for a fresh installation, the second one can be used in case of an upgrade.

5.1. Installation Checklist for Fresh Installation

12

This checklist can be used whilst performing a fresh installation of WebCenter (meaning WebCenter
was not installed on the same machine(s) before).

Please complete the Installation Checklist in the same order as listed here.

O

Note: Do not run this installation from a network share.

On the Application Server...

Install ArtiosCAD Enterprise located on the WebCenter DVD.
Install License Server Components from the ArtiosCAD Enterprise Installer.

Activate Network Licenses via the Network License Manager:

[IwebCenter (Standard or Advanced)
L1cAD Engine
CloBGE

|:|Optional licenses

If you are going to use MS SQL Server (no prerequisites for Oracle):

[ install MS .NET framework 3.5 (run the script from the WebCenter DVD to install it).

[ install MS .NET framework 4.5 (run the script from the WebCenter DVD to install it).

Note: For servers with Windows Server 2012 or with access to the Internet, this will
happen automatically.

Oinstall the SQL Server 2012 SP1 Express Edition Database engine for WebCenter or SQL Server
2017 Express Edition or SQL Server 2019 Express Edition.

O Always install SOL Management Studio on the Application Server.

|:|A|ways install SQL Command Tool on the Application Server.
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Create the local BGSYSTEM Windows user (run the script from the WebCenter DVD to create it)
and enter a password.

Create the FileStore folder and share it as a network folder with all rights enabled for the
BGSYSTEM user.

Install the Application Server component of WebCenter; build the Database schema and
REBOOT.

Install the OBGE from the Automation Engine DVD by selecting the option: Install Automation
Engine 23.11 as On Board Graphics Engine (OBGE) for WebCenter.

Configure the Access Point (formerly known as Hot Folder) in the Automation Engine Pilot to
generate view files for graphic files.

On the Web Server...
Install and configure IS 10 (Windows Server 2016) on the Web Server.

It is recommended to auto install IIS using the provided PowerShell Script from the installation
disk, to configure IIS on Windows Server 2012 or later.

Make sure that Enable 32-bit programs in IIS is set to False.
Increase the upload limit in the request filtering.

Install the Web Server component of WebCenter and REBOOT.

On the Application Server...

Since WebCenter 12.1, services are started automatically. Verify that the following services are
started:

[1JBoss

Clcap-x

|:|Application Monitor

On the Web Server...

Verify that the following services have been started:

[]Tomcat

DAppIication Monitor

Connect to WebCenter in your browser: http:// [WebServer] /WebCenter Inst.
[LJusername: admin. Password: [blank].

O Change password.

Install the ArtiosCAD Defaults in English and Import the Boards (directly from the ArtiosCAD
Defaults Installer).

Run the CADX User Defaults installer, to install optimal Defaults for the WebCenter Cad-X
service

13



ESKO

O

WebCenter

Run the Studio Defaults installer, to install Studio Print Finishing Profiles for working with
advanced material effects in 3D visualization

5.2. Installation Checklist for Upgrade

14

This checklist can be used while performing an upgrade installation of WebCenter 23.11 from an older
version.

Please complete the Installation Checklist in the same order as listed here.

O

O O O340 O4d

Note: Do not run this installation from a network share.

On the Web and Application Server...

Stop all WebCenter services.

On the Application Server...

Backup the whole . . \WebCenter\ApplicationServer folder (make a copy, do not move it)
and backup the following:

LIFileStore
[Ipatabase

L1 Email configuration (if you upgrade from a WebCenter< 12)

On the Web Server...

Backup the whole . . \WebCenter\WebServer folder (make a copy, do not move it).

Uninstall the old version of WebCenter on both Application and Web Server and REBOOT
both servers after uninstall. Delete all the sub folders presentin . . \WebCenter
\ApplicationServer.

Remove all WebCenter instances in IIS on the Web Server.

On the Application Server...

Upgrade to ArtiosCAD Enterprise 23.07 located on the WebCenter DVD.

Upgrade the Network License Manager via the Install License Server Components from the
ArtiosCAD installer.

Upgrade WebCenter Licenses and dependants (CAD Engine and OBGE) to WebCenter 23.

If you are using MS SQL Server, make sure that SOL Management Studio is always installed on
the Application Server.

Install the Application Server component of WebCenter using the existing FileStore and
Database. DO NOT REBOOT YET

Re-apply email customization on the Application Server.
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Build the Database schema if this was not done during the installation.

REBOOT

Update to Automation Engine OBGE 23.11and configure the Access Point (formerly known as Hot

Folder)in the Pilot to generate view files for graphic files.

On the Web Server...

Install the Web Server component of WebCenter.

Make sure that Enable 32-bit programs in lIS is set to False.
Re-deploy WebCenter Instance(s) and re-apply customizations.

REBOOT

On the Application Server...

Since WebCenter12.1, services are started automatically. Verify that the following services are
started:

[lJBoss
Cdcap-x
O Application Monitor

On the Web Server...

Verify that the following services have been started:

[ITomcat

O Application Monitor

Connect to WebCenter in your browser: http://[WebServer] /WebCenter Inst.

Ll Username: admin. Password: [ old admin password].

Install or merge the ArtiosCAD Defaults in English and Import the Boards (directly from the
ArtiosCAD Defaults Installer).

Install the ArtiosCAD Defaults in English and Import the Boards (directly from the ArtiosCAD
Defaults Installer).

Run the CADX User Defaults installer, to install optimal Defaults for the WebCenter Cad-X
service

Run the Studio Defaults installer, to install Studio Print Finishing Profiles for working with

advanced material effects in 3D visualization.

15
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6. CHILI-WebCenter Connection

6.1. Share between CHILI and WebCenter

A CHILI share is used to temporarily hold the files while registering them to the CHILI server.
WebCenter will create a sub folders corresponding to the CHILI environments in this CHILI share root
folder.

{ = ] Note:
- The share must have:

« read and write permissions for WebCenter 'BGSYSTEM' user.
« read permissions for CHILI server.

6.2. Requirements for Reverse Proxy for CHILI Server

[IS ports accessing CHILI over the WebCenter web server should be:

. 80forllShttp

o« 443 forlIShttps

The https ports must have a security certificate attached to it in order to be able to work with Web
Server.

{ = ] Note: The best practice is to install a properly signed certificate, matching the CHILI server

=% hostname (NOT the tricked hostname) on the CHILI server. In this scenario, the validation of
the SSL certificate will be smooth when the WebCenter Application Server makes a connection
to it.

Alternatively, you may use a self-signed certificate. However, these are not supported for the
WebCenter WebServer. You may get SSL validation errors when the WebCenter Application Server
tries to connect to the CHILI server due to this.

As a work-around, use the WebCenter LDAP CertInstall tool:

« Gotothe<Installation Directory>\ApplicationServer\LDAP.

« Runthe following command:

CertInstall.bat
<chiliserver>:443

« Select the right certificate to install by entering a digit.

« Restart the JBoss.

16
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This will solve the SSL validation problems.

WebCenter
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7. Pre-Installation Steps

18

Execute the following steps to make sure you have all the required information and materials for the
installation.

1. Logonto all servers as a local administrator user.

1 Attention:

Logging on as DOMAIN ADMIN does not ensure you are a member of the local Administrators
group.

Verify that the account you are using to log on to each machine belongs to the local
Administrators group before you continue!

2. Make sure you use compatible software versions:
a) Gather the installation media on CD or DVD for ArtiosCAD Enterprise, WebCenter, and
Automation Engine (OBGE).
b) Only very specific versions of ArtiosCAD Enterprise, WebCenter, and Automation Engine (OBGE)
work with each other.

You CANNOT assume that a new version or build of one product will be compatible with older
versions of the other products.

Software Version Build

ArtiosCAD Enterprise 2am
WebCenter 2
Automation Engine 21

3. Check the licenses for the Esko installers:
a) Gather Graphics and CAD licenses.
b) If thisis an upgrade, you will need to ask for updated license files.
c) Checkthe license files against your software order.

Verify that the licenses have the correct number of users, the expiration date if applicable,
and the correct ArtiosCAD Enterprise, WebCenter, and Automation Engine (OBGE) version
information.

4, Gather the required mail server information:

B4/ Note:
The mail server must be on the same network as the WebCenter Application Server.

Also, ensure this mail server has a send-only e-mail account already created for specific
use with WebCenter notifications (this usually requires creation of an account such as
webcenter@mycompany.com).
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5. Gather the required database information from the database administrator:

Mail Server Information

Mail Server Name

Mail Server IP Address

SMTP Port

WebCenter Sender Address

SMTP Authentication User Name

SMTP Authentication Password

WebCenter

Database

Item

Value

SOL Server

server name

“sa” password

database instance name

database port (default is 1433)

Oracle Server

server name

'sys’ password

TNS name

System ID(SID)

database port (default is 1527)

6. Ask the database administrator whether a custom password for the 'WebCenter' database user will

8. Test the mail server connection:

be required and if so, retrieve the expected target password for this database user.

Perform a Web Server health check:

a) We highly recommend not to begin the install with the Web Server inside the DMZ. It is best to

configure on alocal LAN first.

Get all applications installed, configured, and fully functional before moving the Web Server
inside the DMZ. Otherwise any required troubleshooting will be difficult and will take longer than

needed.

b) Verify that Internet Information Services (lIS) is installed and its services are started: [ISADMIN
and W3SVC (World Wide Web Publishing).

c) Make sure the Server service is running.

19
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a)
b)

WebCenter

Note:
Ensure that you can use telnet commands and that its port is not blocked in any way.

Make sure you test this before starting the installation. IT Administrators often block the
required SMTP ports.

From the Application Server, open a command prompt.
Use a telnet command with the following syntax: telnet <mail server name or ip>
<smtp port#>.

For example, my mail server name ismail .eskowebcenterl.comand my SMTP portis 25.
| would type: telnet mail.eskowebcenterl.com 25.

You are looking for a successful response (for example like the one below); a 220 response is
good.

telnet mail.eskowebcenterl.com 25Trying 62.204.32.250...Connected to
mail.eskowebcenterl.com (62.204.32.250).220 mail.eskowebcenterl.com Mail Server;
Mon, 2 Jun 2014 11:26:40 EST

Type QUIT to exit the telnet command.

9. Make sure the Server service is running on the Application Server.
10. Check the Database Server:

a)

b)

c)

Ensure the correct database engine, version and service pack are installed. See section Install
SOL Server 2017 Express Edition on the Database Server.

For SQL Server 2017/2019 or Express 2017/2019 verify these configurations:

« Must be configured to run in Mixed Mode for authentication;

« Language/Character set of SQL Server must match the Operating System language;

« TCP/IP must be enabled.

- If anamed instance is used, the SQL Server Browser must be set to start automatically (and
must be running).

This assumes that the system is protected by an external firewall.

11. Check performance for all servers:

a)

For all servers (Web, Application, Database), ensure Windows System Performance is set to
Adjust for Best Performance:

Go to Control Panel > System > Advanced and select Adjust for Best Performance from the
Performance list.

Ensure Control Panel > Automatic Updates is set to Download updates for me, but let me
choose when to install.

Windows Updates have been known to interfere with WebCenter operation: some updates lock
down ports and stop services related to web and internet.

It is your responsibility to test Microsoft updates before applying them to production servers.
Ensure Windows Firewall is disabled:

Go to Control Panel > Network Connections, right-click on the active network connection and
choose Properties. On the Advanced tab, ensure Internet Connection Firewall is disabled.
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d) Stop and temporarily disable virus software.

Temporarily stop virus services on the Web Server and the Application Server as they are known
to interfere with the WebCenter installation script.

Only after the software is installed should you enable the virus software again.
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8. Installing WebCenter

Installing WebCenter is a multi-step process spread over two or three servers depending on your
configuration. We strongly recommend having three servers.

8.1. Overview of the Installation Procedure

This is a broad overview of the steps required to install WebCenter.

1. Perform the Pre-Installation Steps on page 18.

2. Onthe Database Server, optionally create a database called WebCenter4 0 if using Microsoft SQL
Server. If you do not create the database at this point, it will be done by the WebCenter installer.

If using Oracle, we recommend that the SID (System Identifier) of the database be WCenter,
but it can be anything; just make sure you know the exact name so you can enter it while loading
WebCenter on the Application Server.

3. Onthe Application Server:

a) If using Microsoft SQL Server or SQL Server Express Edition, install Microsoft SQL Server
Management Studio (if you have not done so already). This is provided as part of the MSSQL
Express installer provided on the DVD. If you are using Oracle, it is advised to also install SQL
Developer Studio, which can be downloaded from the Oracle web site.

b) Install ArtiosCAD Enterprise.

Even if the Application Server already has a version of ArtiosCAD Enterprise on it, you must load
the version that came with WebCenter.

For more information on loading and configuring ArtiosCAD Enterprise, refer to the installation
instructions on its media.
c) Activate the Licenses on page 26
d) Install the WebCenter Application Server.
4. Run the Database Schema Scripts on the Application Server.
Thisis only required if the database schema scripts were not run automatically, or if the automatic

run failed. Running the database schema scripts automatically is preferred. If needed, it is still
possible to run the database scripts manually from the Application Server.

5. On the Web Server, install the WebCenter Web Server.

Reboot the Web Server machine if prompted.
6. Startthe WebCenter Services:

a) Onthe Application Server, start JBOSS and CAD-X.
b) Onthe Web Server, start Tomcat.

{ . Note: These services are set to start automatically by the installer and will thus be started

automatically after each machine reboot. If you prefer to start the services manually, you
may set them to start manually by changing their properties in the Services applet via
Control Panel > Administrative Tools.

22
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{ . Note: Since WebCenter 12 a new monitoring service is installed and started automatically.

' This service can be used by your WebCenter support agent for troubleshooting.

Install the On-Board Graphics Engine (OBGE) from the Automation Engine media. This will take about
a half hour.

{ ' Note:

You must install the OBGE even if you are running a separate Automation Engine production
server.

The OBGE will handle files uploaded through the WebCenter user interface, reducing the
load on your Automation Engine production server.

WebCenter is now installed.

Log on the WebCenter web interface and:

a) Change the administrator password.

b) Configuring the E-Mail Notifications on page 40 if you will be using it.
Install the ArtiosCAD defaults.

See Loading the ArtiosCAD Defaults for details.

8.2. Install SQL Server 2017/2019 Express Edition on the
Database Server

Microsoft SQL Server 2017/2019 Express Edition (supplied with WebCenter)is a free version that can
serve as the database engine for WebCenter.

To install it, use the Install the SQL Server 2017/2019 Express Edition database engine for WebCenter
link on the WebCenter installation media.

Following steps describe how to install the MSSQL Server 2017/2019 Express database on a clean
system:

1.

oG PN

8.
9.

10.
n
12.

When the SQL Server Installation Center launches, select the option New SQL Server stand-alone
installation or add features to an existing installation.

If prompted, accept the License Terms and click Next.

A quick check will be done and the installation will be prepared.

If unsure, unselect the check box.

Select the Features you wish to install. If unsure, enable all except LocalDB.

On the Instance Configuration screen, select Named Instance and name your instance
WEBCENTER. You can also change the instance root directory if you want.

On the Server Configuration screen, you can define separate accounts for each service, leave as
default.

You can also specify your Database Engine Collation, leave as default.

On the Database Engine Configuration screen, choose the Mixed Mode authentication type.

Click Accept for Consent to install Microsoft R open, and then click Next.

Click Accept for Consent to install Python, and then click Next.

Click Accept for Offline installation of Microsoft Learning Server Components, and then click Next.
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Note: The “Offline installation of Microsoft Learning Server Components” needs to
download 4 cabinet files (from the installer) and then point to the folder in the installer.

13. On the same screen, specify the SQL Server system administrator (sa) password.
14. The system will now continue with the installation. The last screen shows that the installation
process was completed successfully. You may be asked to restart the computer.

15. Install SQL Server Management Studio from the Microsoft website. A link to the download page
can be found in the SQL Server Installation Center screen under “Install SOL Server Management
Tools" (prompted via the WebCenter installer).

16. If you now inspect your Programs, you should see Microsoft SQL Server 2017 listed, along with
other tools like SQL Server Management Studio.

17. Install the SQL Command Tool.

18. Launch the SQL Server Management Studio to check the connection to the Database Engine.

19. In case it has not been created yet, add a new database named WebCenter4_0.

20.Launch the SQL Server Configuration Manager to check the TCP/IP and SOL Server service
statuses.

21. Choose SQL Server Network Configuration > Protocols for WEBCENTER >, make sure TCP/IP is
set to Enabled for WebCenter.

22.In the SQL Server Services section, restart the SQL Server service. Also, make sure the SQL Server
Browser service is running.

23.If Microsoft SQL Server 2017 Management Studio is installed, you will also need to install the
Microsoft SQL Command Line Utility (sqlcmd).

8.3. Install the Application Server Components

8.3.1. Install ArtiosCAD Enterprise on the Application Server

1. Logontothe Application Server as a member of the local Administrators group.
2. Loadthe ArtiosCAD Enterprise media that came with WebCenter.

Important:

Even if the Application Server already has a version of ArtiosCAD Enterprise on it, you
must load the version that came with WebCenter. In the case of WebCenter 23.11, you need
ArtiosCAD Enterprise 23.07

Make sure to also run the Install Network License Components installer from the
ArtiosCAD Enterprise Installer.

In order for WebCenter to output PDF files, the ArtiosCAD PDF option must be purchased
and then chosen when installing.

For more information on loading and configuring ArtiosCAD Enterprise, refer to its
installation instructions on the ArtiosCAD media.

3. Inthe Esko ArtiosCAD Setup window, click Install Esko ArtiosCAD Enterprise 23.07.

Depending on your system configuration prior to loading ArtiosCAD, the Microsoft Data Access
Components and MSXML 6 may be copied to your system.
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If the system prompts you to reboot, do so; the installation program will resume automatically when
you log in after the system comes up again. Do not postpone rebooting if the system requestsiit.

The Esko ArtiosCAD Enterprise 23.07 en InstallShield Wizard opens.

a)
b)
c)

d)

e)

f)

9)

h)
i)

Accept the license agreement.

In the Licensing Method screen, choose Network Licenses. Make sure the Server field contains
the name of the Application Server (it should be filled in by default).

In the Setup Type screen, choose Typical for a reqgular WebCenter installation, or Advanced if
you will be working with ArtiosCAD Enterprise.

In the Feature Selection screen, make sure PDF Import/Export is enabled.

Note: You will only see this screen when performing an Advanced setup to work with
ArtiosCAD Enterprise.

In the Advanced Options screen, you can leave the default options selected. If you wish to
change them please see the ArtiosCAD documentation for details.

Note: You will only see this screen when performing an Advanced setup to work with
ArtiosCAD Enterprise.

In the User Files Folder screen, keep the default location for the storage of user files, or Change
it if desired. If you change the location to another system, use a UNC locator (for example \
\system2\designs)instead of a mapped drive letter.

Note: You will only see this screen when performing an Advanced setup to work with
ArtiosCAD Enterprise.

Click Install.
Once the installation is complete, click Finish to close the installer.

If the system asks you to reboot, do so.

Note: You will need to perform extra configuration later to work with ArtiosCAD Enterprise.

Note: Since ArtiosCAD Enterprise 14.0, you can install the Boards automatically during the
ArtiosCAD Defaults installation, this is highly recommended. In case you do not choose to
install the Boards during the ArtiosCAD Enterprise installation, you will have to import them
manually later.

Create a Detailed Installation Log

For Installation debugging and troubleshooting purposes, you can create a detailed installation log file
for any Esko Installer programs. To do this:

Run setup using the following syntax: Path+program space /v"/I*v space path+logfilename

For example: For ArtiosCAD Enterprise installation from CD-ROM in my D:\ drive,

Open acommand prompt and Change to the D:\ drive
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8.3.2.

8.3.3.

26

« Type: setup /v'/I*v c:\temp\ACsetup.log”

Activate the Licenses

If you have not done so already, install the Network License Components from the ArtiosCAD
Enterprise Installer first.

Activate your licenses using the Esko Network License Manager.

{ . Note: To perform this task, consult the Network License Manager User Manual.

You need to activate:

« your ArtiosCAD Enterprise license.

» your WebCenter licenses (your basic WebCenter license and any additional WebCenter license you
have, for example WebCenter Task Management, WebCenter Advanced Approval, Reporting, etc.).

- yourlicense for the OBGE (Automation Engine license).

{ . Note: To link the licences, open the ArtiosCAD enterprise application.

Install the WebCenter Application Server

The Application Server components of WebCenter can be installed from a link on the installation
media.

Before doing so, click the link on the DVD to Create the local BGSYSTEM Windows user, if this user
was not created earlier. The BGSYSTEM user creation tool will give you the option to set a custom
BGSYSTEM user password.

1. Logontothe Application Server as a member of the local Administrators group.

2. Insert the WebCenter media into the media drive, and click Software Installation on the menu that
appears at left, then Install WebCenter 23.11.

3. The setup wizard opens with a Welcome screen. Click Next.

4. Inthe License Agreement screen, read the agreement, and if you agree to it, select | accept the
terms in the license agreement and click Next.

5. Select either Simple (default) or Advanced Installation. Keep Simple (default) selected unless you
mean to specify non-default values for either Installation Size, Image Viewer Service or Database
User management.

6. Inthe Custom Setup screen:
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5] WebCenter 12 - InstaliShield Wizard (et S|

Custom Setup 1 b I
Select the program features you want installed.

Click on an icon in the list below to change how a feature is installed.

Feature Description

% | webserver These files are needed for the
WebCenter Application server to

= This feature will be installed on local hard drive.

El- =) = | WebCenter

== : This feature, and all subfeatures, will be installed on local hard drive.

¥ This feature will not be available.

|| Install to:

InstallShield

Space [ < Back ][ Mext = J [ Cancel ]

a) Click the icon next to WebServer and select This feature will not be available.

b) Click the icon next to Application Server, and select This feature, and all subfeatures, will be
installed on local hard drive.

c) If desired, click Change to change the installation folder.
d) Click Next.

7. Inthe WebCenter File Storage Folder screen, choose the location where all data files uploaded to
WebCenter will be stored (the FileStore).

Note: If you want to change the FileStore location, click Change... and browse to your

“==% desired location or enter a UNC address. Using a UNC location such as \\system
\sharename\FileStore isthe most reliable option. The FileStore should be on a
partition with at least 50 GB of free space.

—@_ Troubleshooting:

If the installer fails to create the FileStore, it will give you a message saying that you have to
set it up manually.

Go to the folder that you will use as a FileStore (by default, C: \Esko\Artios\WebCenter
\FileStore, orthelocation of your choice), and share it (typically to the user BGSYSTEM).

Click Next.
8. Inthe Web Server System screen, enter the name you will give to the Web Server and click Next.

Note: Once you have completed the installation and launched WebCenter, the Application
w== Server must be able to resolve the Web Server name you have entered here into an IP
address.

9. In the Database Configuration screen, enter your database information:.

a) Choose your Database program (Microsoft SQL Server or Oracle).
b) Enter the name of your Database Server in Database server system.
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c) Ifyouchose...

« Microsoft SQL Server, enter your Database Instance Name. By default, this is WEBCENTER
(using the SQL Server 2017 Express Edition installer on the WebCenter installation media
created this instance).

- Oracle, enter your Database System Identifier (SID).

Click Next when done.

10. A custom WebCenter database user password can be set. In that case you will need to provide a
password value. This screen will only be shown in case of an Application Server installation.

Note: This screen appears only for Advanced installation.

1. Choose between a Standard (default) and an Extra Large deployment. If Extra Large is selected,
Tomcat and/or JBoss (depending on the server being installed) will be able to allocate 3 times more
memory as is the case with a Standard installation.

Note: This screen appears only for Advanced installation.

12. Choose between an Internal or External (default) View server. If Internal is selected, the View
Server runs inside the JBoss process. If External is selected, an additional process running the
View Server will be started automatically. For the External view server to work, other ports need to
be openin the firewall between the web and the application server: 14444,

Note: If installing Web and Application server component separately - a matching mode
(either external or internal) has to be selected for both the Application server and Web
server - otherwise the Viewer will not function properly.
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5 WebCenter - InstallShield Wizard

View Server
Plaase make a cholce.

The view server renders the data for viewing in WebCenter.

() Internal

Ls

When 2t to ntemnal, WebCenter will run the view server within the default Applicaton

SEMer.

(@) External

When sat to extemal, the view server will run in a separate process managed by the
Application server,

IMPORTANT: IF you dhoase this option, this requires port 14444 to be open between
the web server and the application server.

InstallShistd

13. Click Install in the Ready to Install the Program screen.

14. The Esko Station Information Service may be installed if this is the first Esko software being
loaded on the machine.
If it installs, click Continue when it is done, or wait 10 seconds for the process to continue
automatically.

15. Click Finish when the installation completes.

16. If prompted, reboot the system.

A Attention: This isimportant; do not postpone this step!
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Note:

If during the installation a custom password was set for the local BGSYSTEM user the
following WebCenter Services need to have their Log On information changed to reflect the
custom password:

«  WebCenter JBoss Application Server
« WebCenter Cad-X Server

In the server Services, right-click the WebCenter Service and choose Properties. Go to the
Log On tab of the properties window and update the password of the BGSYSTEM user to
the password that was set earlier. Click Apply, go back to the General tab, and click Start to
start the Service.

8.4. Run the Database Schema Scripts on the Application
Server

30

Since WebCenter 12.1, it is no longer necessary to run the database schema scripts manually. The
database schema scripts can now be run from the installer dialog, for both local and remote databases.

When the database scripts are run automatically, a system console readout window will show feedback
on the progress. Individual SQL statement blocks are displayed as they are being executed.

{ ' Note: There is a known limitation in the Database Schema Script where the execution of

' the script might not complete correctly if the SA password contains non-alphanumeric
characters. We strongly advise to run the script with an SA user whose password only contains
alphanumeric characters.

To run the database scripts automatically, database connection parameters need to be entered in the
Database Configuration dialog which is displayed during the installation of the WebCenter Application
Server:

Choose your database type from the Database program list.

Enter the database host name in the Database Server system field.
For SOL, enter the instance name in the Database Instance Name field.
For Oracle, enter the SID in the Database System Identifier (SID) field.

The checkbox Run DB update scripts during installation determines whether the database schema
scripts are run automatically during installation (preferred), or not.

o oaN

6. If running the scripts automatically is enabled, the DB sysadmin connection password field
becomes available. Enter the password of the default database administrator user for your
Database Server in this field.

If you still want to run the scripts manually, do the following:

1. Locatethe ServerTools\update db.bat fileinyour WebCenter installation folder (for
example C:\Esko\Artios\WebCenter\ServerTools\update db.bat).

2. Runthisfile with the appropriate parameters in the console.



ESKO

WebCenter

Run this file without parameters first to see help about which parameters you need to use.

« If you have a SOL database, you will see this:

C=“Ezko“Artios~MebCenter-ServerTools >update_dh_bat

llebCenter Database Updater

Minimally required argument iz an ‘sza’ password

Full usage:

npdate_dh._bat <sa_password> [ {db_type> [ <{db_host> [ <{db_instance> [ <dbh_sa_use
> 1111

Parameters other than the password are optional. The sequence of

parameters is not. If you want to specify a certain parameter, you need to
specify all preceding parameters. Any of the params you do not specify.

will default to the value specified at installation time. If you need to pass
empty parameters, use "o

dh_type can be mssglex or mssgl
mesglex (default)> will create the wehcenter DB if it doesn’t exist yet
If you want to switch to oracle a reinstall iz reguired.

Current defaults are:
{dh_type?> = mssglex
<db_host> = RDUMWC11
{dh_instance> = WEBCENTER
{dbha_user> = sa

C:“Esko~ArtiossWehCenter ServerTools_

« If you have an Oracle database, you will see this:

:sEzkosArtiossHebhCentersServerTools update_db.bat
JehCenter Databhase Updater

inimally required argument is a ‘sysdba’ password
Full usage:

ipdate_dh.hat <dba_password?> [ <{db_host>[:<{db_port>] {db_service_name> [ <{dba_us
er?> [ {db_string_data_type> [ <{db_data_tahle_space? [ <db_temp_tabhle_space> [ <d
_index_table_space> 1 1 1 1 1 1

arameters other than the password are optional. The sequence of

parameters is not. If you want to specify a certain parameter,. vou need to
pecify all preceding parameters. Any of the params you do not specify.

#ill default to the value specified at installation time. If vou need to pass
empty parameters, use '

If vou want to switch to MS SQL a reinstall is required.

urrent defaults ave:
db_host>[:<{db_port>]1 = RDUMUCH4
db_sevrvice_name> = HE

dba_user> = sys
db_string_data_type> varchar2
db_data_tahle_space> USERS
db_temp_tahle_space> TEMP
db_index_tahle_space> = USERS

:sEzkosArtiossWebCentersServerTools >
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8.5. Install the Web Server

8.5.1. Uninstall lIS on the Web Server if Configured Incorrectly

In some cases IIS may already be installed on the Web Server, but configured incorrectly. For example,
your hosting company may have set up IIS for you. In this case, IIS needs to be uninstalled. After which
it can be installed again and configured correctly.

The procedure below describes how to uninstall [IS 7.

Start the Server Manager.
Navigate to the Roles section using the navigation tree.
Click Remove Roles.

N

The Remove Roles Wizard is started, use this to remove the lIS role. Removing roles and services
from the server can take a couple of minutes.

5. You may get prompted to restart your server. If so please do this.

8.5.2. Install IIS on the Web Server

If lIS is not installed on your Web Server, you need to install it. The procedure below explains how to IIS
8 on Windows Server 2012.

{ . Note: From WebCenter 18.1installation, IIS can also be installed with a script provided in the

' Installation disk.

1. Openthe Server Manager.
2. 1IS 8: In the Select installation type screen, select Role-based or feature-based installation.

3. 1IS 8: In the Select destination server screen, select the appropriate server(local is selected by
default)and click Next.

4. Inthe Select serverroles screen, select Web Server (11S).

If the wizard prompts you to add features required for the Web Server, do so.
5. IIS 8: In the Select features screen, you do not need to add any additional features. Click Next.
6. 1IS 8: Click Next in the subsequent Web Server Role (lIS) screen as well.
7. Inthe Select role services screen:
a) Enable ASP, ISAPI Extensions and ISAPI Filters in the Application Development section.
If the wizard prompts you to add role services required for ASP, do so.

b) In Health and Diagnostics, enable HTTP Logging, Logging Tools, Request Monitor and Tracing.

c) In Management Tools, enable IS Management Tools and IS 6 Management Compatibility, IS 6
Metabase Compatibility, IS 6 Scripting Toolsand IIS 6 WMI Compatibility

d) In Common HTTP features, make sure Default Document, Directory Browsing, HTTP Errors and
Static Content are enabled.
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e) In Security, make sure Request filtering is enabled.
f) In Performance make sure to enable Dynamic and Static Content Compression.

In the Confirm installation selections screen, check the settings and click Install.
This installs the IIS 8 Role with the settings you have selected and the default settings.

The Installation Results screen should show Installation succeeded.
Click Close to exit the wizard and restart the server if prompted.

8.5.3. Install the WebCenter Web Server

The Web Server components of WebCenter can be installed from a link on the WebCenter installation
media.

1.

2

Log onto the Web Server as a member of the local Administrators group.

Ensure that Internet Information Services (lIS) has already been loaded by verifying that the
Internet Information Services applet is in Administrative Tools in the Control Panel.

Note: If it has not been loaded, you must load it through Add/Remove Windows
Components in Add/Remove Programs in the Control Panel.

Insert the WebCenter media into the media drive, and click Software Installation on the menu that
appears at left, then Install WebCenter 23.11.

4, The setup wizard opens with a Welcome screen. Click Next.

Choose the Simple or Advanced setup. Advanced setup contains Deployment Size and View
Server.Application Server installation must match with the choosen setup.

In the License Agreement screen, read the agreement, and if you agree to it, select  accept the
terms in the license agreement and click Next.

In the Custom Setup screen:

a) Click the icon next to WebServer, and select This feature, and all subfeatures, will be installed
on local hard drive.

b) Click the icon next to Application Server and select This feature will not be available.
c) If desired, click Change to change the installation folder.
d) Click Next.

In the Option Selection screen:
a) Enter the name of the Application Server.

This should be a different machine than the one currently running the installation.
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Note:

You cannot configureWebCenter with IP addresses. If the web server is not able

to find the application server via name resolution, you can map the IP address

of the application server and the hostname of the application serverinthe C:
\Windows\System32\drivers\etc\hosts file. Forexample: 10.31.140.69
myappserver.

» For more details, read this Knowledge Base Article.

« Configuring to use NAT translation.

b) If you want to install WebCenter using an already-existing IIS website (rather than the Default
Web Site), select it in the list.

c) Click Next.

9. Click Install.

10. The Esko Station Information Service may be installed if this is the first Esko software being
loaded on the machine.
If it installs, click Continue when it is done, or wait 10 seconds for the process to continue
automatically.

11. Click Finish when the installation completes.

12. Reboot the machine if prompted.

Start the WebCenter Services

After installing WebCenter, you need to start its services using the Services applet in the Windows
Administrative Tools.

Start the WebCenter Services on the Application Server

Log on to the Application Server as a member of the local Administrators group.

Click Start > Settings > Control Panel > Administrative Tools > Services.

Select the WebCenter JBOSS Application Server and click Action > Start.

If not started yet, select the WebCenter Application Monitor service and click Action > Start.
Select the WebCenter CAD-X Server and click Action > Start.

If you want to change the services to start automatically when the machine reboots, do so now:

I N

a) Right-click a WebCenter service and choose Properties.

b) Inthe General tab, choose Automatic in the Startup type list.
c) Click OK.

d) Repeat for each service that has to start automatically.

7. Close the Services tool and log off.

Start the WebCenter Services on the Web Server

1. Logontothe Web Server as a member of the local Administrators group.
2. Click Start > Settings > Control Panel > Administrative Tools > Services.
3. Start the Tomcat service:
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a) Right-click Tomcat Web Server and choose Properties.
b) Inthe General tab, choose Automatic in the Startup type list.

This makes the service start automatically when the machine reboots.
c) Click OK to close the Properties dialog.
d) Select the Tomcat Web Server and click Action > Start.

4. If not started yet, select the WebCenter Application Monitor service and click Action > Start.
5. Close the Services tool and log off.

Easily Identify when WebCenter is Ready to Access

WebCenter services load a lot of data into memory during startup of its services. It is important to
watch the CPU activity before accessing a WebCenter site.

You want both the Web Server and the Application Server to have a CPU activity of under 5% before
accessing the site, otherwise all components may not have started and you may experience error
messages. Another way is to check whetherwcr jboss srv.exe threads exceed 160 and

wcr tomcat srv.exe threads exceed 100.

To help watch the CPU activity easily, add the CPU performance monitor to the system tray of each
WebCenter server. To do this(on both the Web Server and the Application Server):

1. Create a new shortcut in theStart Menu > Programs > Startup folder.
2. BrowsetoWindows\system32\TASKMGR.EXE.
3. Setthe shortcut to Run "Minimized".

8.6. Install the On-Board Graphics Engine (OBGE) on the
Application Server

The Automation Engine On-Board Graphics Engine or OBGE is required for WebCenter systems to
generate view data.

(f Note: The Automation Engine OBGE installer is not included on the WebCenter DVD. The OBGE
installer must be run separately from the available Automation Engine DVD.

8.6.1. How to Perform the Automation Engine 23 System Readiness Check

Before you install the OBGE, a System Readiness Check is required. This checks whether the operating
system is suited for installing and running this Esko product.

1. Onthe DVD, in the section Software installation, click the type of installation that fits your purpose
(as explained in Types of Installations).

2. Inthe section Installation, under Instructions, click Run the Automation Engine System Readiness
Check.

3. Atthe end of the Readiness Check, read the resulting messages carefully.
4. If the Readiness Check resulted in any problem, correct it before proceeding.
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8.6.2.

8.6.3.

36

5. Click Exit.

How to Install the Prerequisite Components

Depending on the products to be installed on this particular system, various components are required
for installation. The installation wizard for these prerequisite components checks the licenses, lists the
prerequisite components to install, requests confirmation for installation and then installs the required
components.

The installation wizard installs the following components:

« Microsoft Visual Studio Redistributables

- Database Engine for the Automation Engine components (if you choose a Standard Automation
Engine Installation)

Follow these steps:
1. Onthe DVD, in the section installation, click Install the Prerequisites Components.

2. Follow theinstructions of the installation wizard.

3. When you choose a Standard installation, when asked to enter a password for the SQL Server, enter
aPassword, confirm it and click Use Password.

Note: During the pre-installation of the Database Engine for Automation Engine, the
Microsoft .NET Framework will be installed. You may get a warning saying that the system
needs to be rebooted, followed by a fatal error "The SQL Server instance is not installed". If
this happens, reboot your server and install the prerequisites again.

4, Depending on your activated licenses, the Automation Engine Prerequisite Components
Installation process may ask you separately about the CAD-X component installation for both the
Standard Edition component and the Enterprise Edition component. If the Automation Engine is
installed on the Application server, Click No.

5. Click Exit.
You will be redirected to the installation page to continue with the next step.

How to Install Automation Engine 23

1. After running the System Readiness Check and installing the License Server Components, when
all prerequisites are fulfilled, you can start the installation.

2. Click the Install Automation Engine 23 link on the installation page.
The Automation Engine 23 Software Installation wizard will open up.

3. Follow the instructions of the installation wizard.

4. Read the Software and Data license agreement carefully and select Yes, | accept the license
agreement.

5. When asked to select the products to install on this system, select Automation Engine 23.
The group Common Components cannot be deselected and will be installed on all systems.
6. Select the Destination Folder for the chosen products or accept the defaults.
Follow the instructions of the installation wizard.
8. At the end of the installation, click Finish.
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In case of a clean installation, a pop-up dialog asks the user name and password to use as the System
Account for installing the Windows services. The proposed default user name is BGSYSTEM and the
password must be provided, either for an existing local user or domain user, or for a local user to be
created. The check continues until a strong enough password is provided. If the password does not
match for the existing user, an error dialog will indicate “wrong user name and password".

{ ' Note: You can later change this system user using the Server Config tool on the AE server

' itself.

‘ ' Note: Learn more about Users and Groups in the separate chapter Pre-Install IT Requirements.

=l

After installation of Automation Engine, a shortcut named Automation Engine Server Config is put on
the desktop of the server computer.

Now continue with your Initial Basic Setup.

Connecting WebCenter to the ESKO Cloud OBGE

When a user uploads a viewable file to WebCenter and the system is licensed to use the Convert OBGE
module a document task will be created to generate the following information using the Cloud based
OBGE: Thumbnail, Deep Zoom preview files, XMP metadata and a text scrape. As this information is
created it will be made available to the end user in WebCenter.

The following viewable files are supported: TIFF, PNG, JPEG, PSD and PDF.

The Action History of the document can be checked to see the status of the OBGE task. Any issues with
the conversion will be listed here.

{ ' Note: The Convert OBGE Module needs to be licensed on your WebCenter instance.

Perform the following tasks for connecting WebCenter to the ESKO cloud OBGE:

1. Connect to Esko cloud account with valid equipment id and token.

2. Configure a new Esko Cloud Connection in the Asset Management Connections Page.This
connection must be for Cloud Service Type Convert.

3. Settothe Convert service endpoint for the Esko Cloud environment where your Esko Cloud Account
is active.

4. Generate the cloud token for the created equipment.

Enter the Esko Cloud account repository ID and Workspace Name.

6. Click Save.

o

{ ' Note:

]
« Ifthe entered information is valid and WCR can connect to Esko Cloud you will be

allowed to save the connection.

« If multiple Esko Cloud Connections of type Convert are configured in the system, the
system will use the first one for OBGE requests.

« The Flag WC_ENABLE_CLOUD_OBGE_PREVIEW needs to be enabled by Esko even if you
are licensed for Convert OBGE.
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9. Testing WebCenter
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On the Application Server and the Web Server, ensure IIS and the WebCenter services are started and
configured to start automatically.

After starting/restarting the WebCenter services, always wait a few moments until the CPU processor
activity on both servers become idle (<6%) before attempting to access the login page.

Testing each facet of WebCenter in the exact order below helps to easily and quickly identify points of
failure, if any.

[IS Connectivity - use IIS Manager to access the WebCenter_Inst site

[IS Security settings - can access the home page after logging in

Database connection and Schema - can add a new record to the database
FileStore connectivity - can write a file to the FileStore and then retrieve it

View Data generation - can upload a graphic file and the OBGE does its job

View and Annotate applet - can launch the applet successfully on a Graphic file
View the status in the Trouble shooting tool for View Server Deployment Status
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10. Configuring WebCenter

10.1. Configure the OBGE

WebCenter

The Pilot lets you configure the Automation Engine On-Board Graphics Engine (0BGE) for use with

WebCenter.

You must create a container and a hotfolder pointing to the WebCenter FileStore.

10.1.1. Create a Container

1. Logontothe Application Server as a member of the local Administrators group.

2. Double-click the Pilot icon on the desktop.

3. Inthe Logon Information dialog, enter BGSYSTEM as the User Name and the enter the same
password that is set for the BGSYSTEM in WebCenter. Type the name of the Application Server in

Server Name. Click OK.

This opens the Pilot. User creation in Automation Engine is done by following steps provided here.

4. Go to Tools > Containers to open the Containers window.

ExamplelobContainer file:/irdalpha25/Example)obContainer

= containers [':' (=] ﬂ_hj
File Edit
= Q
Hame = State Location
EmptyCeontainer Ready file:/irdalpha25/EmptyContainer -

To more about Containers in Automation Engine, you can read here.

In that window, go to File > New or click ="

This opens the Create Container Wizard.
6. Inthe Welcome screen, click Next.

7. Inthe Location of the Job Container screen, select Existing Shared Folder and click Next.

8. Inthe Location of the Network Folder screen, type the name of the Application Server in the

Computer Name field and click Next.

9. Inthe Select the shared folder screen, select the FileStore share and click Next.
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10. Click Finish and close the Containers window.

10.1.2. Create a JDF Hot Folder (Access Point) for WebCenter

Choose Tools > Access Points from the Pilot main menu.
Click the Create a new Access Point button.

Choose type Folder and click OK.

Enter a Name.

S

In the Folder Settings tab, specifiy the hotin folder. This should look like: file://myserver/FileStore/
JDFHotfolder/hotin.

6. Inthe Monitoring tab, set Check every...minutes to a low number preferably, the recommended
settingis 1.

7. Inthe Automatic Actions tab, fill in the hotout folder in the Move File to and Output Folder fields.
This should look like: file://myserver/FileStore/JDFHotfolder/hotout. Make sure Action is set to
Process JDF.

8. Click OK.

The Hot Folder/Access Point now appears in the Pilot and is ready for use.

10.2. Configuring the E-Mail Notifications

Use the E-Mail Notifications page to configure the e-mail environment for the notifications framework.
Only WebCenter Administrators can access this page.

10.2.1. Configure E-Mail Notification

While logged in to the WebCenter web interface as an administrator:

1. Go to Admin > Configuration > E-Mail Environment Setup.
2. Setupyour e-mail environment:

Setting Description

E-Mail Service Protocol WebCenter only supports the SMTP protocol.
E-Mail functionality To enable/disable e-mail functionality.
enabled

E-Mail debugging output in | To enable/disable e-mail debugging output in log files.
log

E-Mail Service Host The address for the preferred mail server that will act as the server
for dispatching WebCenter e-mail notifications (this server has to
comply to the selected protocol type (see above)).
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Setting Description

E-Mail Service Port Number | The port number on which the defined mail server is listening for
incoming e-mails.

Outgoing E-Mail Supply a valid e-mail address. This will be used in the "From" e-mail
Notifications' "FROM" header for every e-mail sent by WebCenter.

Address

Use TLSv1.2 Select this option to use TLSv1.2 when you are trying to connect

over SSL to the SMTP server. WebCenter uses the STARTTLS
protocol command to indicate that, it can upgrade the insecure
connection to TLSv1.2. To ensure that TLSv1.2 is used during the
connection, the SMTP server should be configured to prevent
insecure connections.

E b ] Note: This however does mean that if the smtp server
doesn't support TLSv1.2, the insecure connection will be
used instead.

E-Mail Session Select this option if the mail server connection requires
Authentication authentication with a user name and password.

E-Mail Service Username Provide the mail account user name if authentication is required.

E-Mail Service Password Provide the mail account password if authentication is required.

E b ] Note: This password is stored inan encrypted form.

3. Click Send E-mail.

The E-Mail Environment Settings page appears.

Recipient*
Subject* Testing WebCenter e-mail notification environment

E-Mail Body* | E-Mail notification environment settings are OK

‘Send E-Mail Reset to Default

4. Type a Recipient address and click Send E-mail.
WebCenter attempts to send an e-mail to the recipient.

The E-Mail Configuration page appears, displaying a message depending on the result of the test:
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» E-Mail Sent: The environment is set up correctly.

« JMS System Error: Communication with the JBoss' proprietary messaging framework failed.
An administrator should check the JBoss server configuration and/or log files for possible
causes.

« Mail Server Connection Error: The connection to the specified mail server did not succeed.

Either the data the administrator supplied on the e-mail environment setup page was incorrect,
or the mail server is currently down.

An administrator should either check the e-mail environment settings for possible misspellings
or contact the mail provider as to the status of the mail server.

(f ’ Note: The settings you defined are saved in the database. For updates from older
WebCenter installations, the email setup is first loaded from the old emailconfig.xml
file and the settings are subsequently stored in the database.

10.3. Configure WebCenter for Use with ArtiosCAD
Enterprise

10.3.1. Configuring BLOBs

42

ArtiosCAD Enterprise supports the use of BLOBs in the database. BLOBs are Binary Large OBjects -
files stored as data in the database. Using BLOBs is transparent for the user.

When you configure ArtiosCAD Enterprise to use BLOBs, it also stores managed documents in the
WebCenter FileStore as a cache to improve performance. If you delete a file from the FileStore, the
next time you save it in ArtiosCAD Enterprise, it will be recreated in the FileStore from the BLOB.

f ~  Note:

You should decide if you want to use BLOBs when you install WebCenter. Switching to using
BLOBs after having used ArtiosCAD Enterprise is not recommended or supported.

Editing appconfig.xml on the Application Server

To enable BLOBs, you must change a line in a configuration file on the Application Server. On the
Application Server:

1. LoginasAdministrator orasauserwith administrative privileges.

2. Make abackup copy of C:\Artios\WebCenter\config\appconfig.xml. This file willbe on
the C: drive no matter where you installed WebCenter.

3. Openthe file named in the previous step in a text editor such as Notepad.
4. Scroll down to <store_files_in_blob value="false"/> and change false to true.
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5. Save the file and exit the text editor.

Restarting Services

Once you have changed appconfig.xml onthe Application Server, restart all the Application
Server's WebCenter services to start using BLOBs in ArtiosCAD Enterprise.

1. Onthe Application Server, still logged in as Administrator or as a member of the local
Administrators group, open the Services applet in the Administrative Tools group in Control Panel.
2. Restart the following services by clicking each one and then clicking the Restart link:

a) WebCenter JBOSS Application Server
b) WebCenter CAD-X

3. Close the Services applet and log off the Application server.

ArtiosCAD Enterprise is now configured to use BLOBs. Note that WebCenter will keep copies of
managed documents inits FileStore to improve performance.

10.3.2. Step 2 - Optionally Uploading Boards

In case the boards were not installed yet, follow this procedure after logging in to WebCenter for the
first time:

Login onthe Web server as a member of the local Administrators group.
Run the setup program with WebCenter DVD.
Click Upload Boards.

In the Log In To Web Browser dialog box, enter the address of the WebCenter server, an admin
user's username, and that user's password. Click OK.

N

5. An Upload Boards progress bar will appear.
6. Click Close when the upload finishes.

10.3.3. Step 3 - Creating Shared Defaults for the First Time

The next stepis to run the ArtiosCAD Defaults Manager installed when you installed ArtiosCAD
Enterprise on the Application server. The first time you install ArtiosCAD Enterprise 16 or later, you
have to create the Shared Defaults. You can choose to either create completely new Shared Defaults,
or you can choose to migrate older Defaults that are merged with the defaults for the version you are
installing. In the future, you will add a new version's Defaults to the existing Shared Defaults Project.

You may also use this utility to migrate location and user defaults from older versions of ArtiosCAD
Enterprise to newer versions of ArtiosCAD Enterprise.

{,] Note:

Even if you do not plan to use WebCenter in combination with ArtiosCAD Enterprise, it is

still necessary to install the Defaults in order for WebCenter to be able to process CAD files
properly. Therefore, it is highly recommended to install the Defaults, even if you do not plan to
use CAD files initially.
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Note:

The system you use for loading the Defaults must be able to keep the Defaults on it. You will
have to follow the same process to load future Defaults and the new installation will reference
the older version’s Defaults as part of its installation. We recommend using the Application
Server for this process.

Note:

This procedure takes a significant amount of time. We recommend starting it and doing
other things until it completes.

Login to the Application Server as a member of the local Administrators group.
Click Start > All Programs > Esko > Defaults Management to start the Defaults Manager.

In the Login to Web Browser dialog box, enter your WebCenter server URL, admin username, admin
password, and click OK.

4. Click Create new shared defaults.

A progress bar appears. This step will take a few minutes.

6. Click Close when the installation process is done.

10.3.4. Configuration in the WebCenter User Interface

44

Note: See the WebCenter Administration Guide for more details about the following steps.

Log on to WebCenter with the admin account (see Log On to WebCenter and Change the Admin
Password).

Configure a Company and Location for the initial ArtiosCAD Enterprise users.
Create a custom group, if desired, for the initial ArtiosCAD Enterprise users.
Create the initial ArtiosCAD Enterprise users. While creating them:
a) Make sure they are at least Project Managers with Limited Visibility of Companies and Groups.
b) Assign them to the Company and Location you created.
c) Assign them to one or more groups.
Even if you did not create any custom group, you should assign them to the USERS group.
Invite them to the System Defaults Project (which is Shared Defaults in ArtiosCAD Enterprise).

Tip: You can do this either individually for every user or once through Group membership if
you added all users to the same group (such as USERS).

Inviting them to the Project means that they will be able to use the Defaults.

In order for users to change Shared Defaults, they must have Full permissions on the Project and be
members of the ADMINS group.

Note: All ArtiosCAD Enterprise users must be invited to the System Defaults Project. Users
who are not invited to the project will receive a UFANEX error when they launch ArtiosCAD
Enterprise.
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10.4. Secure your WebCenter Site with SSL

SSL is a protocol for securing communication over the Internet. It works by using a private key to
encrypt data that is transferred over an SSL connection.

URLs using an SSL connection start with https:// instead of http://.

To use SSL, you are required to obtain an SSL certificate and install it into Internet Information
Services(lIS) on the Web Server.

(f Note: We strongly recommend you secure your WebCenter site with SSL, especially if you plan
to use WebCenter over the internet (not only within a Local Area Network).

10.4.1. Secure the WebCenter Web Server with SSL

You will need to:

1. Create a Certificate Signing Request (CSR) on page 45.
2. Request an SSL Certificate from a Certificate Authority on page 46.
3. Install the Intermediate SSL Certificate on page 47.
4. Install your Signed Certificate on page 47.
5. Export your Certificate if Necessary on page 48.
You only need to do this if you haven't installed the certificates directly on your Web Server.
6. Bind your Certificate to your WebCenter Site on page 49.
7. Redirect HTTP Traffic to HTTPS on page 49.

Create a Certificate Signing Request (CSR)

To get an SSL certificate, you need to first create a Certificate Signing Request, that you will send to a
Certificate Authority.

1. Onthe Web Server, click Start, then Administrative Tools, then Internet Information Services (lIS)
Manager.

2. Inthe Internet Information Services (lIS) Manager dialog, click your server name (on the left).
3. Inthe dialog's central pane, double-click the Server Certificates icon in the Security section.
4. In the Actions pane on the right, click Create Certificate Request...

This opens the Request Certificate wizard.
5. In the Distinguished Name Properties screen, enter your information as follows:

«  Common Name: the name through which the certificate will be accessed (usually the fully-
qualified domain name, for example www .domain . com).

- Organization: the legally registered name of your organization/company.

- Organizational unit: the name of your department within the organization.
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« City/locality: the city in which your organization is located.
- State/province: the state in which your organization is located.

- Country/region: the two-lettered ISO-3166 country code of the country in which your
organization is located. You can find a list of valid country codes on http://www.ssl.com/csrs/
country_codes.

Click Next.
6. Inthe Cryptographic Service Provider Properties screen:

« leave Cryptographic Service Provider to Microsoft RSA SChannel Cryptographic Provider,

» inBitlength, select 2048 or higher.

Click Next.

7. Inthe File Name screen, enter a name for your Certificate Signing Request, and select alocation in
which to save it.

Click Finish.

Request an SSL Certificate from a Certificate Authority

The customer is responsible for choosing the SSL provider (Certificate Authority), obtaining
certificates, as well as following that company's specific instructions for installation and configuration.

Esko cannot obtain SSL certificates on behalf of its customers.

1. Send your Certificate Signing Request file to a public Certificate Authority.

Note:

« Ifyoudo anInternet Search for “SSL certificate”, you will find many providers with
different pricing and options. We have good experiences with VeriSign, Network
Solutions, Godaddy.com, and Thawte.

« The application process can take up to 30 days... Start the application process well in
advance!

- If your company has a DNB (Dun & Bradstreet) number, the application process will be a
lot easier and quicker if you can provide it.

- Your certificate will be linked to your website (for example webcenter.domain. com).
Changing your website name will require a new certificate.

2. The Certificate Authority will provide you with:

« anintermediate certificate, verified by the root certificate installed by default on your Web
Server (where you created the Certificate Signing Request),

Note: You may need to download this from a web link.
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- your server certificate, verified by that intermediate certificate (signed by the Certificate
Authority).

Make sure you have both certificates before going further! You will need to install both of them on
your Web Server.

Copy those certificates to your Web Server.

Install the Intermediate SSL Certificate

You need to install the intermediate certificate before you install your signed certificate.

1.

On your Web Server, click Start, then Run...

2. Typemmc and press Enter.

3. Inthe Microsoft Management Console (Consolel) window that opens, go to File > Add/Remove

® N o p

10.

n

12.

Snap-in...

In the Add or Remove Snap-ins dialog, select Certificates, and click Add.

In the Certificates snap-in dialog, select Computer Account, and click Next.

In the Select Computer screen, select Local Computer, then click Finish.

Click OK in the Add or Remove Snap-ins dialog.

In the Consolel window:

a) expand the Certificates (Local Computer) folder,

b) right-click Intermediate Certification Authorities, and go to All Tasks > Import...
In the Certificate Import Wizard dialog:

a) click Next to get to the File to Import screen,

b) browse to the location containing your intermediate certificate file,

c) inthe Open dialog, change the file extension filter to PKCS #7 Certificates (*.spc;*.p7b),
d) selectyour* iis intermediates.p7b file, and click Open.

Note: Only install your intermediate certificate, not your signed certificate in this area!
Installing your signed certificate here would remove your intermediate certificate from
the list, and you would need to reinstall it.

e) Click Next.
In the Certificate Store screen:

a) select Place all certificates in the following store,

b) click Browse, select Intermediate Certification Authorities in the Select Certificate Store pop-
up, and click OK,

c) click Next.

Click:

a) Finishin the Certificate Import Wizard dialog,
b) OKin the Certificate Import Wizard pop-up stating that the import was successful.

Close the Consolelwindow, then click No in the pop-up asking to save the console settings.

Install your Signed Certificate

Once your intermediate certificate is installed, install your signed certificate:
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On the Web Server, extract your * . cer certificate file from the zip file you got from the Certificate
Authority.

Click Start, then Administrative Tools, then Internet Information Services (11IS) Manager.
In the Internet Information Services (1IS) Manager dialog, click your server name (at left).
In the dialog's central pane, double-click the Server Certificates icon in the Security section.

o oroaN

In the Actions pane at right, click Complete Certificate Request...

This opens the Complete Certificate Request wizard.
6. Inthe Specify Certificate Authority Response screen:
a) browse toyour * . cer certificate file,
b) enter a Friendly name for your certificate.
This will be used by the server administrator to easily distinguish the certificate.
c) Click OK.

Your certificate is now installed. If you cannot see it yet in the Server Certificates list of the Internet
Information Services (lIIS) Manager dialog, press F5 to refresh.

Export your Certificate if Necessary

We recommend you create the Certificate Signing Request and install the certificates directly on your
WebCenter Web Server.

However, if you do this on another server, you can export the signed certificate then import it on your
Web Server.
1. If you haven't done so already, install the intermediate certificate on your Web Server.
2. Exportyour signed certificate from the server itisinstalled on:
a) InInternet Information Services (IIS) Manager, select your certificate in the Server Certificates
list and click Export... in the Actions pane at right.
b) Inthe Export Certificate dialog that opens:

1. Type afile name in Export to, or click the browse button to navigate to a file in which to store
the certificate for exporting.

2. Type aPassword if you want to associate a password with the exported certificate.
3. Retype the password in Confirm password and click OK.
This exports your certificate toa .pfx file.
3. Import your signed certificate on your Web Server:
a) Click Start, then Administrative Tools, then Internet Information Services (11S) Manager.
b) Inthe Internet Information Services (1IS) Manager dialog, click your server name (at left).
c) Inthe dialog's central pane, double-click the Server Certificates icon in the Security section.
d) Inthe Actions pane at right, click Import...
e) Inthe Import Certificate dialog that opens:

1. browse to your Certificate file (.pfx),
2. enter the Password associated with your certificate if there is one,
3. make sure that Allow this certificate to be exported is selected.

Note: Thisisimportant, as due to a bugin IS, the site binding will not work if the
certificate is not exportable.
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4. Click OK.

Your certificate is now installed on your Web Server. If you cannot see it yet in the Server Certificates
list of the Internet Information Services (1IS) Manager dialog, press F5 to refresh.

Bind your Certificate to your WebCenter Site

Once you have installed your certificate on your Web Server, you need to bind it to your WebCenter site,
so that the certificate will be used to authenticate your WebCenter site when users browse to it.

1. Stillin the Internet Information Services (11IS) Manager, right-click the Default Web Site node in the
Connections pane, (or the node of the IIS website you have deployed your Web Server on if it's not
the default website) and select Edit Bindings...

2. Inthe Site Bindings dialog that opens, click Add.
3. Inthe Add Site Binding pop-up:

a) Choose https as Type.

b) Leave the default https Port (443).

c) Inthe SSL Certificate list, select your Web Server.
d) Click OK and then OK again.

Type: IF address: Port:

E
E Ihttps j IAII Unassigned j I.H3
ht
]

=

X

Host name:

551 certificate:

webserver

Mot selected

L L L LI

Cancel |

Redirect HTTP Traffic to HTTPS

To ensure security, end users should only use https: // to access your WebCenter site. If someone
accidentally uses http:// instead, they will not be using a secure connection.

To avoid this, you can make sure http: // traffic to your WebCenter site is automatically redirected to
https://. Thiswill be transparent for the users (they will not get an error page but will simply be able
to access your site through https://).

For this, you need to download a(free) extension for IIS.
1. Onyour Web Server, download and install the URL Rewrite extension for IIS.

Go to http://www.iis.net/downloads/microsoft/url-rewrite, click the Install this extension button
and follow the steps on screen.

2. Inthe Internet Information Services (lIS) Manager, make sure SSL is not required so users don't get
an error when connecting to your site usinghttp://:

a) Select the Default Web Site node in the Connections pane, (or the node of the IIS website you
have deployed your Web Server on if it's not the default website).
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b) Double-click SSL Settings in the center pane.

c) Under SSL Settings, make sure that Require SSL is not selected.
Click Default Web Site or the node of your IIS website again, then double-click URL Rewrite in the

center pane.
Create ablank inbound rule:

a) Click Add Rule(s)... in the Actions pane on the right.
b) Inthe Add Rule(s) pop-up, click Blank rule under Inbound rules, then click OK.

The center pane now shows the Edit Inbound Rule form.

Edit the rule as follows to perform the automatic redirection:

a) Enter a Name for the rule, for example HTTP to HTTPS redirect.

b) Under Match URL, fill in the settings as follows:

WebCenter

Requested URL Matches the Pattern
Using Reqular Expressions
Pattern (.*)
Ignore case on

c) Under Conditions, select Match All in Logical grouping.

d) Add the first condition:

1. Click the Add... button to open the Add Condition pop-up.

2. Fillin the settings as follows:

Condition input

{HTTPS}

Check if input string Matches the Pattern
Pattern off
Ignore case on

This ignores addresses starting with https: // (they don't need to be redirected).

3. Click OK.
e) Add the second condition:

1. Click the Add... button to open the Add Condition pop-up.

2. Fillin the settings as follows:

Condition input

{SERVER_ADDR}

Check if input string

Does Not Match the Pattern

Pattern

Ignore case

on
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Thisignores addresses using 1localhost through IPV6(::1), as forcing https:// for those
would give a certificate error as the one below (because the certificate is linked to your site
name and not the server's IPV6 address).

@ There is a problem with this website's security certificate.
R

The security certificate presented by this website was issued for a different website's address.

Security certificate problems may indicate an attempt to fool you or intercept any data you send to the
Server.

We recommend that you close this webpage and do not continue to this website.
i@ Click here to close this webpage.

";:3' Continue to this website (not recommended).

(*) More information

3. Click OK.
f) Add the third condition:

1. Click the Add... button to open the Add Condition pop-up.
2. Fillin the settings as follows:

Condition input {SERVER_ADDR}

Check if input string Does Not Match the Pattern
Pattern 127.0.0.1

Ignore case on

This ignores addresses using localhost through IPV4(127.0.0.1), as forcing https:// for
those would give a certificate error (because the certificate is linked to your site name and
not the server's IPV4 address).
3. Click OK.
g) Under Action, fill in the settings as follows:

Action type Redirect

Redirect URL https://website-name.com/{R:1}

where website-name. comis the name of
your WebCenter site, to which you have linked
your certificate

Append query string on
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Redirect type

Found (302)

Your rule should look like this:

ﬁ Edit Inbound Rule

MName:

IH'I'I'P to HTTPS redirect

Match URL
Requested URL:

Pattern:

Matches the Pattern j

Using:

Regular Expressions

&

Il Ignore case

Test pattern... |

Conditions

Logical grouping:

[Match Al 4

Inpuk | Tvpe

| Pattern

{HTTPS} Matches the Pattern

add. ..

{3ERVER_ACDR}  Does Mok Makch the Pattern il Edit... |
{SERVER_ADDR}  Does Mok Makch the Pattern 127.0.0.1
Remove |

Move Up |
Maovwe Down |

[T Track capture groups across conditions

Server Wariablas

Ackion

Action bype:

Redirect j

Action Properties
Redirect URL:

Ihttps A/ rdvnwe 12 . esko-graphics.com/ {R: 1}

I Append query string

Redirect type:

|Found {302)

h) Click Apply in the Actions pane at right.
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You should now see your rule in the URL Rewrite list in the center pane.

6. Browse toyour WebCenter site usinghttp:// and check thatitisredirectedtoahttps://
connection.

10.4.2. Install SSL Certificates on the Workflow Production Server

« you are planning to integrate your Automation Engine server with WebCenter,
- your WebCenter site is secure (it demands https: // connections),

« your Automation Engine server and your WebCenter are not located within the same Local Area
Network,

... you need to make sure your Automation Engine server can communicate with your WebCenter
serveroverhttps://.

1 Important:

If you have installed your certificates properly on the Web Server (the intermediate certificate
and the signed server certificate), this should work without you having to do anything.

If you haven't, or you are still experiencing connection problems, you should import the
WebCenter certificates into the Automation Engine keystore.

This can also apply when WebCenter and Automation Engine are in the same LAN, if
https:// communication is also enforced inside the LAN. Check with your network
administrator if this is the case.

Export the Certificates from the WebCenter Site

1. Logontothe Automation Engine server as a local administrator.
2. Openaweb browser and navigate to the secured WebCenter site.
3. Examine the WebCenter site's certificates.

How you do this depends on the web browser you use:

a) Click the lock icon at the end of the address bar and click View certificates in the pop-up.

/= WebCenter Logon - Microsoft Internet Explorer provided by Esko-Graphics

@ i W | https HWEbse wE II"'F"F'BbCE ker_TI 5t||I | %—
N
x

File Edit ‘“iew Favorites Tools  Help X ‘E 1 . - .
Website ldentification

s R @

¢ Favorites | 55 @ Suggested Sites = @ | Free Hotmail & | Get Mor

Thawte Server CA (SHAT)

' WehCenter L
Fhi-emter togen has identified this site as:

7= wehserer
This connection to the server is encrypted.

Should | trust this site?

Welcome To We

Connecting your Yiew cedificates
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b) Inthe Certificate dialog, click the Certification Path tab.

WebCenter

This tab displays the certificate hierarchy. Each top-level entry in the hierarchy represents a

certificate.

Certificate
General | Details | Certification Path

Certification path

ver Ci (SHA1)

webserver

Certificate skakus:

PX

Wigw Certificate

This certificate is OK,

4. Export all the certificates (top-level entries)in the hierarchy:

a) Highlight the first certificate in the hierarchy (for example, Thawte Server CA (SHAL)).
b) Click View Certificate.

c) Click the Details tab.
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Certificate @g|

General | Details | Certification Path

Show:

Field Value ~
E\-‘ersion 1
ESerial number 3 mE
ESignature algarithinm =n 8
Elssuer el aall )
E'\."ahd Fram - (& B F
[Elvalid to el ™
ESUbjECt | e =i ERe B RN b u ]
EPuinc = = = hd

Edit: Properties. . l [ Zopy to File, . ]

d) Click Copy to File to begin the Export Wizard. Click Next.
e) Select DER encoded binary... (.CER) and click Next.

X]

Certificate Export Wizard

Export File Format
Certificates can be exported in a variety of file Farmats,

Select the Format wou wank o use:

(*)DER encoded hinary ¥,509 [, CER)

() Base-64 encoded ¥.509 { CER)
() Cryprographic Message Syntax Standard - PKCS #7 Certificates { P7E)

[ < Back “ Tdext = l[ Cancel ]

f) Click Browse or type in a valid path and name the certificate (*.cer). We recommend using a
short path and name (such as c:\temp\vali.cer). Click Next.
g) Click Finish, then OK and once more OK.
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h) Repeat these steps until you have exported all the certificates. Close the web browser when you
are finished.

Import the Certificates into the Workflow Server Keystore

While still logged on to the Automation Engine server as a local administrator, import the certificate
files into the Automation Engine keystore:

1. OpenaDOS command prompt.

2. Change to the Esko Automation Engine software directory which contains the keytool utility: c:
\esko\bg_prog_fastservercltnt_v210\jre\bin
For ESKO Software platform , this will typically be c:\esko\bg_prog_fastservercltnt_v210\jre\bin

3. Runthe import utility for each certificate downloaded, in the proper order: keytool
—importcert -file <path>\*.cer -alias <aliasname> -keystore
<keystore path>.

Your <keystore_path> is the pathtobg prog fastserver vxxx\jre\lib\security
\cacerts. Forexample: c:\esko\bg prog fastserver v210\jre\lib\security
\cacerts.
You will be prompted for a password. The password is: changeit (case sensitive).

4. You might be asked to trust the certificate. Enter Y for Yes.
It is also possible that the tool tells you that this certificate is already installed. If so, that’s ok, go on
with the next certificate.
You should get a successful message like Certificate was added to keystore.

5. Repeat for each certificate to import in the hierarchy.

6. Reboot the Automation Engine computer to ensure that the changes take effect.

Example

You are running Automation Engine 21.11 and the Automation Engine server software is installed on
E:\Esko.

You have downloaded two certificates from the WebCenter site in the folder ¢ : \ temp:
valicert.cerandstarfield.cer

valicert.cer was firstin the hierarchy, so you would import this first, then repeat for
starfield.cer

You would proceed as follows:

1. Usingacommand prompt, gotoe: \esko\bg prog fastserver v140\jre\bin.

2. TypeKeytool —-importcert -file c:\temp\valicert.cer -alias valicert -
keystore e:\esko\bg prog fastserver v210\jre\lib\security\cacerts

If asked for the password, type changeit.

If asked to trust the certificate, type Y.

Repeat the same command for the next certificate, startfield.cer.

LIRS

Reboot the Automation Engine computer to ensure that the changes take effect.




ESKO

WebCenter

Import the Certificates into the Workflow Client Keystore

With a secured WebCenter site (requiring https: / /), you cannot check the connection between
Automation Engine and WebCenter with the Check Connection button in Configure.

To be able to do this, you need to install the Web Server certificates in the Automation Engine client

keystore too(even if the client is running on the same machine as the Automation Engine server).

Tip:

You should also do this if publishing fails because Automation Engine doesn't have the
appropriate certificates. Typically, this gives an error message like the one below:

javax.net.ssl.SSLHandshakeException: sun.security.validator.ValidatorException:
PKIX path building failed:

sun.security.provider.certpath.SunCertPathBuilderException: unable to find valid

certification path to requested target

1. While logged on to the Automation Engine client machine as a local administrator, open a DOS
command prompt.

2. Change to the Esko Automation Engine software directory which contains the keytool utility:

\bg prog fastservercltnt vxxx\jre\bin

For ESKO Software platform, this will typically be c: \esko
\bg prog fastservercltnt v210\jre\bin

(4 ’ Note: For the client, make sure tousebg prog fastservercltnt and not
bg prog fastserver as for the server!

3. Runthe import utility for each certificate downloaded, in the proper order: keytool
—importcert -file <path>\*.cer -alias <aliasname> -keystore
<keystore path>

Your <keystore_path> is the pathtobg prog fastservercltnt vxxx\jre\lib\security

\cacerts. Forexample: c:\esko\bg prog fastservercltnt v210\jre\lib
\security\cacerts.

You will be prompted for a password. The password is: changeit (case sensitive).
4. You might be asked to trust the certificate. Enter Y for Yes.

It is also possible that the tool tells you that this certificate is already installed. If so, that’s ok, go on

with the next certificate.

You should get a successful message like Certificate was added to keystore.
5. Repeat for each certificate to import in the hierarchy.

6. Reboot the Automation Engine computer to ensure that the changes take effect.

10.5. Install Certificates for LDAPS on the Application Server

To connect your WebCenter installation to a secure LDAP server (LDAPS), you have to install a
certificate obtained from that LDAPS server.
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1. Openacommand prompt on the WebCenter Application Server.

2. Change directory to the location of \WebCenter\ApplicationServer\LDAP
\CertInstall.bat.

3. Issue the following command: Certlnstall servername:port, where servername is the name or IP of
the LDAP server and port is the port used for secure connection (typically 636).

INDOWS' system32hcmd.exe

C:“Ezko“HebCenter~ApplicationServer~LDAF>dir
UJolume in drive C iz System
Uolume Serial Number is BCSB-7E1F

Directory of C:<Ezko“WebhCenter-Applicationferver-LDAF

A3.-11.-288% <DIR> .
A3.-11.-288% <DIR> .
A3.-10.-208% 656 CertInstall_bat
A3.-85.-2089 1,886 InstallCert5SavingTlrustManager.class
A3 -85-2009 5.587 InstallCert.class
@383 .-2009 M L.842 InstallCert.java
= 12,291 bytes
2 Dirds2 L.242.126,.336 bytes free

C:“Ezko“MHebCenter~ApplicationServer~LDAP>CertInztall esko—graphics.com:-636

4. To make changes active ensure that you restart JBoss, if JBoss was running.

If successful, alist of certificates sent by the server is displayed (ignore any additional messages).

nd.exe - CertInstall webcenter?.e

Server sent 1 certificateds):

1 Subject CN=wehcenter2.esko.com
Iszuer CHN=webcenter?.eszko.com
shal 25 57 4e e? 9d 33 3e 15 ea A3 8F 6e A3 6a fa c? 27 eb 77 A
md5 S5a Bf 6a B8 cl1 Ad 61 3d bc e2 ?2f 73 58 45 397 fo

Enter certificate to add to trusted keystore or 'q’ to guit: [11

5. Toinstall a given certificate, enter its numberin the list and press Enter.

We suggest that you install all certificates. Only one certificate can be installed each time you run
Certlnstall so it can be necessary to run it multiple times.
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WINDOWS  system32',cmd.exe

[2]1: Objectld: 2.5.29.37 Criticality=falsze
ExtendedKeylsages
serverfiuth

lgnrlthm. [SHA1withRSA]

. B R P 4, £
Lix...EE.?

...u..Z...JJ.
ju. CB . - hu

Added certificate to keystore ’jssecacerts’ using alias ‘webcenter2.esko.com—1*
Copying the keystore file jssecacerts to C:»Program FilessJavasjdkl.5.@8_15%jrexl
ibN\security

1 file<{s)> copied.

C-“Ezko-UebCenter~ApplicationServer~LDAP>

Note:

Troubleshooting the certificate installation

The certificates should be properly installed. If not, try these troubleshooting tips:
- Server or port name is not correct

If the supplied parameters are wrong, the result can look something like the following:

Inztalling Certlflcate for 58L connection....

Loading KeyStore C:nProgram Files“Javasjrel.6.B_87-lib\securitycacerts...
Opening connection to esko—graphics.com:636...

Starting £5L handshake. ..

Javax.net.zszl_8ELHandshakeException: Remote host cleosed connection during handsh
ake
at com.zun.net.szl.internal.szsl.88L8ocketImpl.readRecord{Unknown Sourcel

c at cgm.sun.net.ssl.internal.ssl.SSLSucketImpl.perfurmlnitialHandshake(Un
ource
com.zun.net.szl.internal.ssl.88L8ocketImpl.startHandzhake {Unknown Sou

com.zun.net.szl.internal.ssl.88L8ocketImpl.startHandzhake {Unknown Sou

InztallCert.maintInstallCert. java:562>
: java.io.EOFException: 58L peer shut down incorrectly
cgm.sun.net.ssl.internal.ssl.InputRecurd.read(Unknuun Source’
- more
Could not obtain server certificate chain
Copying the keystore file Jjsszecacerts to C:“Program Files“JavasJjdki.5.B@_15%jre-]
ib“zecurity
The zystem cannot find the file specified.

C:~EskowWebhCentersApplicationferver~LDAF>

In this case, contact your IT system administrator and verify the parameters supplied.
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10.6. Integrate WebCenter with a Workflow Production
Server

You can configure WebCenter to integrate with your existing Automation Engine production server.

In this documentation, we assume that you have both these applications installed and running properly.

10.6.1. Understanding WebCenter Integration

WebCenter can run without Automation Engine, but its full potential is realized when integrating both
systems.

Integrating WebCenter with an Automation Engine production server allows you to upload production
files to WebCenter for approval and advanced project management.

To make this collaboration between the systems possible, you must:

» Add the WebCenter site information in the Automation Engine Configure window.
« Configure the Job Web Page URLs in the Automation Engine Configure window.

« Set up the WebCenter View information for the Automation Engine users.

« Set up the Publish on WebCenter ticket.

Add the WebCenter Site Information

1. Launch the Automation Engine Pilot and connect to the production server with an administrator
account.

2. Choose Tools > Configure.

3. Inthe Configure window, select WebCenter Sites in the left pane.

4. Click the +icon.

Delivery

Website: lhttp:HWCRSERVER,-'WebCenrer_Insr ]I QOpen...

(™ WebCenter and Automation Engine are in the same LAN

WebCenter's Approval Client:
Name:

Password:

| Check Connection |

5. Inthe Website field of the Delivery area, enter the URL of the WebCenter site (for example:
http://wcrserver/WebCenter Inst)

Note: If your site uses secure HTTP, make sure to enter an HTTPS address.
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Click Open... to test the connection. The login page for WebCenter should appear. If it doesn't,
check your settings.

If the Automation Engine server and the WebCenter Application Server are not on the same LAN,
deselect WebCenter and Automation Engine are in the same LAN.

If using Automation Engine 18.0.1,18.0, or 16.1.1to connect to WebCenter for outside-LAN approval
feedback, you need to install a hotfix on Automation Engine for this functionality to still work after
updating to WebCenter 18.1.

The hotfixes can be downloaded from mysoftware.esko.com:

« Automation Engine 16.1.1: HF_201801047_-20181212_AE-WCR_18_1
+ Automation Engine 18.0: HF_201806059_-20181212_AE-WCR_18_1
« Automation Engine 18.0.1: HF_201811018_20181212_AE-WCR_18_1

Older versions of Automation Engine are not officially supported.

The User Name and Password fields then become available. This is where the Automation Engine
Approval Client configuration in WebCenter is used.

Create a user name and password combination in WebCenter, then enter that same (case-sensitive)
user name and password in the appropriate fields in Automation Engine Configure.

Click Check Connection to test the connection.

Important: You must be using the Pilot on the Automation Engine server itself to run this
check.

A dialog box appears, proving that the connection works and displaying the WebCenter version
number.

If the Connect to JDF Processor area is visible, leave JMF selected in it.
Click Check to test the connection.

An Info dialog appears, reporting that the connection is OK. Click OK.

If this dialog does not appear, check your settings.

On the left of the Configure window, scroll down and select the new WebCenterl entry under
WebCenter Sites.

Click File > Rename and enter a descriptive name for your WebCenter site.
Click File > Save to save the settings.

Configure the Job Web Page URLs

The Job Web Page enables you to go to your WebCenter project from within your Automation Engine
Job.

1.

Launch the Automation Engine Pilot and connect to the production server with an administrator
account.

Choose Tools > Configure.
In the Configure window, select Jobs > Job Web Page in the left pane.

In the Address field, enter the URL of the WebCenter site (for example: http://pacwebserver/
WebCenter).
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5. Stillin the Address field, append this text to the end of the URL: /projdetails.jsp?
projectName=

1 Attention: This is case-sensitive; enter it exactly as written. Do not include a space or
period at the end.

Click +[ ]InsertSmartNames.

In the SmartNames column, scroll down and click JobName.
Click Insert to append it to the URL in the Address field.
Click Close to return to the Configure window.

© ® N

The result should resemble http://pacwebserver/WebCenter/projdetails.jsp?
projectName=[JobName] with[JobName]in green.

10. Click File > Save to save the settings.

You can now right-click your Job folder in the Automation Engine Pilot and select Go to Job Web Page;
this opens the WebCenter project associated with your Job in a browser.

Set Up the Publish on WebCenter Ticket

The Publish on WebCenter ticket in Automation Engine creates output and uploads the resulting files
to WebCenter.

For more details, please see the Automation Engine documentation.

1. Launch the Automation Engine Pilot and connect to the production server with an administrator
account.

2. Click the Tickets view.

3. Locate the Publish on WebCenter default ticket, right-click it and click Duplicate....

4. Inthe Save As pop-up that opens, replace the word Default in the Save As field with a meaningful
name (for example the name of your WebCenter site).

5. Inthe Scope area, select the Global option.

If you have no blue job folders containing files, you are not prompted to select the scope.
6. Click Save. The new ticket should appearin the list.
7. Double-click your new Publish on WebCenter ticket to change its settings.
8. Onthe Destination tab, define where you want to publish your file:

a) Inthe Site list, select your desired WebCenter site.
b) Inthe Project field, enter the JobName SmartName so that the files are published to the
WebCenter project corresponding to your Automation Engine job.
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Note:

« The project does not have to exist in WebCenter at upload time. If the project does
not exist, it will be created. In this case, the person that does the upload from
Automation Engine needs to be Project Manager in WebCenter! Otherwise the
upload will fail.

« If your main goal is not to upload files but to create WebCenter Projects through
Automation Engine, we recommend you use the Create or Modify WebCenter
Project ticket instead (see the Automation Engine documentation for more
information).

c) Leave the Folder and Project Template fields blank unless you know the exact names of the
folder and project template you want to use for every new Project.

In this case, enter them as appropriate; all new WebCenter Projects created with this ticket will
use these values.

Note:
« The Project Template field refers to a template in WebCenter, not Automation
Engine.

« You canonly use templates that are visible by the WebCenter user performing the
upload (see sub-step f).

d) Enter a Document Name if you want your published document to have a name different from the
input file name.

Note: If the document already exists, the task will create a new version of that
document. If it exists but is in a different folder, the task will fail.

e) Enter a Document Description if desired; this description will be available in WebCenter as a
Version Comment.

f) Leave the User Name and Password fields blank unless there is a specific (and valid!)
WebCenter user who will own each document revision published using this ticket; in that case,
enter the appropriate information.

If you leave these fields blank, anyone using the ticket will have to supply a valid user name and
password each time it is used.

. Onthe Publish tab:

a) Leave Prepare for viewing and annotating and Make available for download selected.
b) Inthe Allow Downloading in WebCenter area, choose the kind of files to upload to WebCenter.

+ Input files are the original files themselves.
- PDF files for proofing are proxy files created by using the selected ticket. If you choose
PDF files for proofing, leave the default Create SoftProof for WebCenter ticket selected, or

choose another ticket if desired. Proxy files uploaded in this manner will have Download PDF
for printing as an option in WebCenter.

The combination of preparing for viewing but not making available for download is intended for
Graphics files that only need Approval.
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10. On the Approval tab, deselect Start the Approval Cycle.
11. Click Save. Then click Yes to confirm overwriting the ticket.

10.7. Expose WebCenter to the Internet

Exposing WebCenter to the Internet is the responsibility of your local IT department. Esko cannot do
this for you.

10.7.1. Register a Domain Name
Register and pay for a domain name, such as www.esko . com, to allow internet users to navigate to
your WebCenter site.

Once you have registered the domain name, your company is the only one authorized to use that
specific domain name for a certain period.

- Contact a proper authority (VeriSign, GoDaddy, etc) and purchase a domain name.

10.7.2. Contact Your ISP to Set Up an A Record

The purpose of an Arecord is to associate your domain name to your public firewall/router, so web
traffic(HTTP and HTTPS) going to the domain name is routed to that public firewall/router.

Think of this as telling the Postman how to get to your mailbox.

(f ’ Note: It takes several days for the A record information to propagate around the world.

1. Identify the public IP Address of your router/firewall.
This is the hardware appliance your Internet connection is plugged into(i.e. T1, DSL).

For example: My T1is plugged into a firewall with 66.55.44.33 as public IP address.

2. Contact your ISP and ask them to add an ‘A’ Record (Address record) to the global DNS (Domain
Name Servers), associating your domain name and your router/firewall public IP address.

3. Verify that you can ping your domain name from computers inside and outside your LAN.
4. Ensure the reply you get contains the correct IP address for your public firewall/router.

Example

MClis your ISP. You contact MCl and ask them to add an A record for your new domain name,
www.esko.com, to forward HTTP and HTTPS traffic to your public firewall IP address of 66.55.44.33.
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After about 3 days or so, this record has been propagated across the world. If someone in Thailand
‘pings’ the domain name www.esko.com, he/she should receive a reply with the IP address of
66.55.44.33.

10.7.3. Move the Web Server Inside the Demilitarized Zone (DMZ)

You should physically arrange the network devices so that the Web Server isin a proper DMZ
architecture (between two firewalls or plugged into a DMZ port of the public router/firewall).

1. Configure Firewall 1(public router/firewall):

a) Allowed to route traffic to Web Server inside DMZ for HTTP and HTTPS.
b) Default ports 80 (HTTP)and 443 (HTTPS).

2. Configure Firewall 2 (gatekeeper for private network):

a) Allowed to route traffic on specific ports to WebCenter's Application Server.
b) Default ports 1099, 2500, 4444.

{ =1 Note: You can change the default port numbers used at any time—to do this, modify the IIS
= settings and the WebCenter configuration files on both the Web Server and the Application
Server to reflect these custom port numbers.

10.7.4. Configure IIS to Receive Traffic

Web traffic is delivered to the public firewall because of the A record. That firewall then forwards the
web traffic to the Web Server inside the DMZ.

The Web Server application (1I1S) needs to be configured to pick up this traffic for processing. To do
this, the Web Server must be assigned a static Private IP Address.

1. Onthe Web Server, click Start > Run and type inetmgr. Then click OK to start Internet Information
Services (1IS) Manager.

2. Expand the Web Site node.

3. Right-click the Web Site node and choose Properties.

4. Click the Web Site tab and verify that the IP Address is correct (or use the drop down list to change
it).

5. Inthe TCP Port field, ensure you are using the correct port for HTTP traffic; the default port is 80
(this needs to match your firewall rules).

6. Close lIS Manager.
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11. Deploying WebCenter
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WebCenter uses a three-tier installation framework to facilitate in-house development and
configuration before deploying it in production form. The three tiers are the Installation version, the
Development version, and the Production version.

Deployment Workflow

The intended workflow is to install WebCenter, deploy it to Development, modify the Development
version, and then when you are satisfied, deploy the Development version to Production.

As time goes by, you can keep modifying the Development version as desired without affecting the
Production version. When you are satisfied with the changes made to the Development version, you
can deploy it to Production.

At the time of deployment, the custom directory is not overwritten if it already exists in a target
instance, so customizationConfig.xml and any other customized files in the custom directory
are not changed. But when a new instance is created by deployment, the custom directory is created
with its default configuration.

The WebCenter Deployment Manager

The WebCenter Deployment Manager, located in Start > Programs > WebCenter, manages the
deployment process. If there is more than one website on the Web Server, choose the website with
which the WebCenter Deployment Manager will work and click OK.

®. WebCenter Deployment Manager g|

Deploy
Inztallation Drevelopment gl Froduction

wWehCenter_Inst wWehCerer_Dey WWehCenter

To further develop the installed version, use the WebCenter Deployment Manager:

« If youwant to change the name of the development version, click the ... button in the Development
area, and specify the new name of the development version. When you have changed the name,
click Deploy Development.

Web authors can then modify the site at http: //WebServer name/WebCenter Dev(or
whatever name you chose earlier), while normal users can still work using the site at http://
WebServer name/WebCenter Inst.

« Once the developed version is ready for production use, use the WebCenter Deployment Manager
again.

If you want to change the name and location of the production version, click the ... button in the
Production area and enter the new name. Then, click Deploy Production.
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The site in WebCenter_Dev will be copied to WebCenter. Production use starts by users pointing
their browserstohttp://WebServer name/WebCenter.

Note:

You can have multiple development and deployment versions of WebCenter by changing the
names for each deployment, e.g. DEV1, DEV_Other, WebCenter_Prod1, and so forth.

Also, the deployment name is not case sensitive, so for example WebCenter_Dev and
WebCenter_dev are considered to be the same deployment instances.

11.1. Creating a base Configuration for WebCenter
Deployment

This describes the default configuration. If a user fails to update
CloudConvertOBGEPreviewParams.json, an error will occur.

The default values are:

« Pagesin folders named with three digits.
» Aliased Pyramid Files

+ 50px x 50px JPEG with file suffix “_50"
+ 100px x 100px JPEG with file suffix “_100"
+ 200pxx200px JPEG

« XMP Metadata with Inkcoverage info.

« SVG Text Scrape
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12.

12.1.

Localizing WebCenter

Localization is the process of making a program ready to run anywhere in the world.

It encompasses modifying the display language, the way units are displayed, decimal separators, time
and date formats, and currency format to match the local user preferences.

Understanding Localization in WebCenter

12.2.

WebCenter uses references to separate language files (text strings files) instead of using hard-coded
words. WebCenter ships with a variety of language files. Additionally, the text strings files can be
translated into any language.

Each WebCenter user can change to a different language in My WebCenter > My Preferences.

The default language can be changed in General Preferences at any time by any WebCenter user who is
amember of the Admins group.

How to Install Custom Translations
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The language files are in the 1anguages subdirectory of the WebCenter installation on the Web
Server, suchas \Artios\WebCenter\WebServer\tomcat\webapps\<site name>
\languages.

They are named wcstrings xx.xml where xx is a two-letter code for the language, for example en
for English, fr for French, and de for German.

1. Copy one of the existing language files, and rename the copy changing the two-letter language
code to the new language code.

{ =w| Note: The language code must match the official list of two-letter ISO 639-1codes at
http://www.loc.gov/standards/is0639-2/englangn.html. For example, a
Danish language word strings file would be named westrings da.xml.

2. Translate the strings in the file.

3. Onthe Web Server, open \Artios\WebCenter\WebServer\tomcat\webapps
\WebCenter instance\config\config.xml ina texteditor or an XML editor. In the
Languages section of the file, add a key for the new language, for example <Language key="da"/>
for a Danish translation.

4. Put the translated language file in the languages subdirectory of the WebCenter installation.
5. Openeveryotherwcstrings xx.xml file and add a <NLanguage_xx>Language</
NLanguage_xx> string after the strings for the existing languages.

For example, add the string <NLanguage_da>Danish</NLanguage_da> to install a Danish strings
file, substituting the word for Danish in the appropriate language for the string file.
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6. If the chosen language is a multi-byte language (such as Japanese, Chinese, or Thai), log on to the
Application Server and edit \Artios\WebCenter\config\appconfig.xml.Change the value
in the index_lang field to the appropriate language code that is listed in the comment below the
field, and save the file.

7. Restart the Web Server to see the changes.
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13. The Help System
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0ld style dynamic help system

WebCenter uses a dynamic help system that checks for the existence of specifically-named
XSL files on the Web Server in \Artios\WebCenter\WebServer\tomcat\webapps\
<WebCenter instance>\help.

A Help link will appear in the menu of the page that has the same name as an XSL file in this directory.
The content of a Help file can be anything provided it is in XSL and the file has an .XSL extension.

Note: Esko recommends the use of xmlspy® for authoring WebCenter Help XSL files. Itis
available from http://www.xmlIspy.com. There are also shareware and freeware XSL editors
available. You could also modify the sample provided using a text editor such as Notepad; do
not use WordPad as it inserts its own formatting codes.

« Tochange the Webmaster contact name and e-mail address displayed on the login help page, edit
login.xsl.

- If using foreign-language files, append _xx (where xx is the code for the language) to the end of the
file name before the extension, such as login_fr.xsl for a French help file for the login page.

When determining if a Help link should be on a page, WebCenter looks for a localized Help file, and then
foran English one if alocalized one is not found. If neither exist, WebCenter does not put a Help link on
the page.

New style dynamic help system linked to help.esko.com

Since WebCenter 12.1, a lot of pages (mostly in the admin section) use a dynamic help system linked
to help.esko.com. When a user clicks the help icon, context-aware help information is displayed. By
default the documentation from help.esko.com is shown, but this behavior is customizable.

It is possible to customize a specific help topic, or to link a subset of help topics to a specific manual or
page. The behavior of the help functionality can be configured in the custom folder on the Web Server.

Each help link has a topic (i.e. common/wc/reference/re_task ). The topic of a help link can be found by
looking at the link address: a help icon always links to help.jsp?topic={TOPIC}&lang={LANG}.

For customization, the following options are available:

» By placing html files in the correct location in the custom folder on the Web Server: Customization
for help pages is done in the custom/help directory. Customization can be done per language (by
adding files to custom/help/{LANG} directory (where {LANG} is the abbreviation for the language in
WebCenter i.e. custom/help/en for English). Customization can also be done for all languages. This
is done by putting files in custom/help/all.

» Byadding a helpconfig.xml file with specific settings to the custom/help folder on the Web Server:
This file can contain a set of rules that will be applied when no specific custom topic is found. In the
custom help file you define rules that match topic names. When a rule matches, the rule is applied
by sending the user to the correct location, defined in the rule.



ESKO

WebCenter

Note:

The system first searches in the language specific custom folder for a customized html file, if
no html file is found for a specific language, it will search in the custom/help/all folder for that
topic.
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14. Upgrading WebCenter

You can upgrade directly to WebCenter 23.11 from older versions.

If you have an older version than 12.0, you will need to first upgrade to WebCenter 10.10r 10.2, make
sure it is running correctly, then upgrade to WebCenter 23.11.

(f ’ Note: The long-deprecated lists backed directly by Excel files stored on the web server are
no longer supported as of WebCenter 23.11. If the customers are still using this type of list, it is
highly recommended to migrated to the database-backed lists before upgrading to WebCenter
23.11.

14.1. Forced System Reboot during Upgrade

When updating WebCenter, a full re-installation is required. You need to remove the existing
installation before installing a new version.

After uninstalling, you have to reboot to be able to proceed with a new Installation process. This is
enforced before installing another version.

(f Note: Reboot pending state of a system can be activated not only by WebCenter but also by
completed Windows updates or other application installation operations.

14.2. Configuration Retained During Upgrade

14.2.1. Retained Configuration Values during Upgrade

WebCenter Installer will store specific configuration values of the existing installation when it is being
uninstalled. These configuration values will be used during the upgrade.

The Installer input fields will use these stored values for the new installation. You only have to verify if
this pre-populated data during the installation process.

The following values are stored by the system:
«  Web Server

« Application Server Hostname
« Application Server

«  Web Server Hostname
« Database Server Hostname
« Database type (MS SQL or Oracle)

« Database Instance name (MS SQL only, default instance can be used in which case this setting s
empty)
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- Database connection SID(Oracle only)
« SA database User password (default password)

i = ] Note:
1. The password value is not retained, if a custom password was used during the
previous installation. You will have to type in this password in this field.
2. Settings made for weekend days other than Saturday and Sunday, has to be made
again in Application server. Refer to the steps here.

- FileStore folder path(s)(UNC path is allowed)

Note: Asthis mechanism includes persistence of custom FileStore path values, the
appconfig.xml configuration file does not have to be modified after re-installing a
new WebCenter version.

{ =

« Installation Choice: Simple or Advanced
« If Advanced Installation is selected, the following choices are retained:

« JavaHeap Space Size: Normal or Extra Large
» View Server: Internal or External
« Database (internal) User password: Default or Custom

i = ] Note: The password field is always left empty.
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15. Prepare for the Upgrade

15.1.

This describes how to upgrade from older versions of WebCenter to the latest build of WebCenter 23.11.

{ ' Note:
]
This procedure applies to all upgrade installations of WebCenter 23.11, even to "minor" updates
between builds of the same version.

Note:

This procedure is fairly complex and involves direct manipulation of core application and
database files.

Expert help is available to perform the upgrade for you at a minimal cost: contact your local
Esko Customer Services division for a quote and scheduling.

Note: When upgrading to WebCenter 23.11 from WebCenter 21.03 or earlier, make sure to run
the Cleanup Tool before initiating the upgrade. The Cleanup Tool can be run from WebCenter
via the Admin > Configuration > Cleanup Tool. Once the Cleanup Tool has finished, proceed with
the Upgrade.

For more detailed instructions than the brief overview provided in this document, please consult the
main WebCenter Installation Guide on the installation media.

Prerequisites for the Upgrade
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Installation Media and Licenses
Make sure you have the following at hand before proceeding:
Media
+  WebCenter 23.11DVD
» Automation Engine 23.11 DVD
Licenses
WebCenter 23.X Network License

Information Needed
Make sure you collect the following information:

+ Thelocation of the FileStore (you can find this information in C: \Artios\WebCenter\Config
\appconfig.xml)

« The database engine to use (Microsoft SQL Server 2012/2014/2016/2017/2019 or Oracle 19¢/21c).

- The name of the Database Server, the Oracle Database Identifier (SID)if using an Oracle database,
and the database administrator password (sys password).

+ The name and location of the WebCenter4_0 database instance (you can find this information in



ESKO

WebCenter

<DRIVE>:\Esko\Artios\WebCenter\ApplicationServer\Jboss\server\default\configuration
\standalone.xml. Use your Esko customer login and password for activating licenses.

+ TheIP address or name of the LDAP server and the port used for the secure connection (typically
636).

If you are upgrading from 16.1.1 or newer to 23.11

WebCenter Installer will store specific configuration values of the existing installation when it is being
uninstalled. These configuration values will be used during the upgrade.

The Installer input fields will use these stored values for the new installation. You only have to verify if
this pre-populated data during the installation process.

The following values are stored by the system:
«  Web Server

« Application Server Hostname
« Application Server

+ Web Server Hostname

» Database Server Hostname

- Database type (MS SQL or Oracle)

- Database Instance name (MS SQL only, default instance can be used in which case this setting is
empty)

« Database connection SID(Oracle only)

« SA database User password (default password)

{ = Note:

1. The password value is not retained, if a custom password was used during the
previous installation. You will have to type in this password in this field.

2. Settings made for weekend days other than Saturday and Sunday, has to be made
again in Application server. Refer to the steps here.

- FileStore folder path(s)(UNC path is allowed)

{ =| Note: Asthis mechanism includes persistence of custom FileStore path values, the
= appconfig.xml configuration file does not have to be modified after re-installing a
new WebCenter version.

« Installation Choice: Simple or Advanced
» If Advanced Installation is selected, the following choices are retained:

« JavaHeap Space Size: Normal or Extra Large
« View Server: Internal or External
- Database (internal) User password: Default or Custom

{ = ] Note: The password field is always left empty.

15.2. Prepare for the Upgrade on the Application Server

1. Copy the following onto the Application Server:
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+  WebCenter 23.11DVD

« Automation Engine 23.11DVD

+ ArtiosCAD enlicense

«  WebCenter 23 license (plus optional module licenses)

« OBGE (On Board Graphics Engine) license
2. Backup:
« theFileStore

« the WebCenter4_0 database
« the \Artios\WebCenter folder

« the \Esko\Artios\WebCenter folder

« any E-mail Notification customizations that may be stored in \WebCenter
\ApplicationServer\EmailNotifications\Custom

« any Auto Translation Service customizations that may be stored in \WebCenter
\ApplicationServer\wildfly\modules\com\esko\webcenter\translator
\main\translator-service-1.0.Jjar

« all other non-standard customizations you may have implemented outside of the custom
folders

3. Make arestore point for the OBGE.
4. Make a backup of the server software configuration.

For detailed instructions on step 3 and 4, please refer to the Automation Engine 21.03 Installation
Manual.

15.3. Prepare for the Upgrade on the Web Server

1. Copy the following onto the Web Server:

« WebCenter 23.11DVD

2. Backup \Artios\WebCenter and any non-standard customizations you have implemented
outside of the WebCenter instances.
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16. Upgrade WebCenter

16.1. Remove WebCenter

1.

On the Application Server:

a) Backup the whole..\WebCenter\ApplicationServer folder (Make a COPY, DON'T MOVE IT) and
backup the following:

» Filestore

« Email configuration (if you upgrade from WebCenter 10.2.x or older)
b) Uninstalled the previously installed version of WebCenter.
c) Delete the WebCenter\ApplicationServer folder with all content.
d) Now REBOOT.

{ . Note: Take care not to remove the FileStore if it is inside a WebCenter folder!

On the Web Server:

a) Backup the whole..\WebCenter\ApplicationServer folder (Make a COPY, DON'T MOVE IT).

b) Uninstalled the previously installed version of WebCenter and REBOOT .

c) Incase you are upgrading from a version 16.x or older, remove all WebCenter instances in lIS on
the Web Server.

d) Remove all WebCenter instances in the installtion by deleting all sub-folders in ..\WebCenter
\WebServer\tomcat\webapps.

16.2. Install WebCenter

1.

On the Application Server, update the older version of ArtiosCAD Enterprise to the latest version
of ArtiosCAD Enterprise, choosing the options described in Install ArtiosCAD Enterprise on the
Application Server on page 24 and the Use the default configuration upgrade option.

Upgrade the license component using the Automation Engine 23.11 DVD:
a) Insert the Automation Engine 23.11 DVD.
If the DVD does not auto-start, double-click setup.exe initsroot folder.

b) Inthe window that opens, click English.
c) Click either:

. Software Installation in the main menu on the left of the window,

« Proceed to the installation >> at the bottom of the window.
d) Click Install on the next page.
e) On the Instructions page, click Run the Automation Engine System Readiness Check.
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At the end of the Readiness Check, read the resulting messages carefully. If the Readiness
Check resulted in a problem, correct it before proceeding. Click Exit in the Automation Engine
System Readiness Check dialog when this is done.

f) Click Install the License Server Components.
g) Click Install the System Controller 1.0 and follow the instructions of the installation wizard.
Activate the Licenses on page 26.

4. Uninstall the old version of ArtiosCAD Enterprise.

Install WebCenter , using the English language installer, on the Application Server and on the Web
Server, making use of the existing FileStore location and WebCenter4_0 database location.

Note: The installers in other languages should not be used, until further notice.

See Installing WebCenter on page 22 for more information on the installation procedure.

6. Install Certificates for LDAPS on the Application Server on page 57.

When the upgrade installation is completed, the search crawler needs to be updated. Thisis to
ensure that the search results are up to date or else may result in incomplete search results. To
rebuild Search Crawler, Go to Configuration > Search Crawler Set up and click on Rebuild Index.
This operation can take several hours depending on the number of projects, tasks, document
(versions) present. Rebuilding the search index has a serious performance impact, and it is advised
to run this over the weekend. Search results will be incomplete as long as the index is being rebuild.
This is to ensure that the search results are upto date and complete.

16.3. Upgrade the OBGE

Note:

« The OBGE must have the same or a later version than the Automation Engine production
server.

« Make sure that you do not update any CADx component while updating the OBGE! CADx
must only be updated by the ArtiosCAD Enterprise installer.

Upgrade the OBGE (On-Board Graphic Engine) to Automation Engine 23.11:

1.
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Upgrade the prerequisite components:
a) Insert the Automation Engine 23.11 DVD.
If the DVD does not auto-start, double-click setup.exe inits root folder.

b) Inthe window that opens, click English.
c) Click either:

. Software Installation in the main menu on the left of the window,
- Proceed to the installation >> at the bottom of the window.

d) Click Install on the next page.
e) Click Install the prerequisite components and follow the instructions of the installation wizard.

Note: Remember to not update any CADx component!
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The prerequisite components are now upgraded.

2. Test the OBGE and check its configuration (Hot Folder and container, see Configure the OBGE on
page 39 for details).

16.4. Configure WebCenter

1. If you had WebCenter customizations:
a) Reapply the email notification customization that you backed up in your custom folder.

Mentions of an older version of WebCenter are automatically updated to "WebCenter 14".
b) Apply any standard customizations you saved earlier to your new WebCenter instance(s).
c) Redo any other non-standard customization that you may have had.

See the WebCenter Customization guide for more information.

Attention:

« Do NOT copy the files as the XML structure might be different and you might break it.
« Do not customize the Default instance of WebCenter as if it doesn't work anymore
you will have to completely reinstall it!

2. Incase running the database scripts automatically (preferred)is switched off, run the WebCenter 14
database scripts.

See Run the Database Schema Scripts on the Application Server on page 30 for more information on
the database schema scripts.

3. Logonthe WebCenter web interface and change the administrator password(see Log On to
WebCenter and Change the Admin Password).

4. Deploy new WebCenter instances as desired.
See Deploying WebCenter on page 66 for more information.

The upgrade is complete.

16.5. Additional step when you upgrade from 18 to later
versions

When performing an upgrade to installation of a WebCenter 18.0 or later, if the Web server is on the
same host as the installer, then the following options are available if the custom folders is backed up:
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Web Server System ‘
Please enter the options for your WebCenter application server. 4

Please enter your options,

Application server system host:

[Eaw 18DL213

115 web site that the web server will be deployed in:

[Defauit web site -

Redeploy web instances:

_ Do not redeploy automatically ‘

[ < Back l[ Next = l [ Cancel

« Redeploy web instances with customizations: This is the default option that redeploys the custom
instances marked during the previous uninstall procedure as well as the custom folders backup.

« Redeploy web instances without customizations: Redeploys the custom instances marked during
the previous uninstall procedure but will not retain the backed-up custom folders.

« Do not redeploy automatically: Will not redeploy any of the custom instances and their custom
folder backups.
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17. Uninstalling WebCenter

® N oo

10.

n

12.

13.

Log on to the Web Server as a member of the local Administrators group.

Stop the lIS Admin service.

Backup all deployed sites within \Artios\WebCenter\WebServer\Tomcat\webapps in case
they are needed in the future.

In WebCenter 18.0 or later, Web server installer records the names of all the custom WebCenter
instances while backing up the custom folder where all Web server based customizations of a given
instance including the default WebCenter_Inst are stored.

Common App Data root folder is used to store the customization files backup on the target Web
server host. The default path on most Windows server would be C:\ProgramData\Esko\WebCenter
\WeblnstanceCustomData.

This folder is the root and each WebCenter web instance custom folder files that was backed up is
stored under a subfolder that takes the name of the appropriate instance.

Use the Add/Remove Programs applet in Control Panel to remove WebCenter.
Manually delete all subdirectories under \Artios\WebCenter.
Logonto the Application Server as a member of the local Administrators group.

Backup \Artios\WebCenter\Filestore andallits subdirectories in case they are needed in
the future.

Use the Add/Remove Programs applet in Control Panel to remove WebCenter.

Manually delete all subdirectories under \Artios\WebCenter

for the Automation Engine Prerequisites

If WebCenter is uninstalled with the intention of installing a newer version (and keeping an existing

database), do NOT delete the filesin \Artios\WebCenter asthey contain information needed
for the new version to run with the existing admin password.

If the OBGE is installed, remove all the Esko products using the Add/Remove Programs applet in
Control Panel. Select all products except the FLEXIm flexid drivers.

Remove ArtiosCAD Enterprise by using the Add/Remove Programs applet in Control Panel. Once all
the products are removed, WebCenter should be completely removed.

Reboot your machine. If you need to install another version, this is a required step.
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